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1 Introduction 

The Event Capture Graphical User Interface (GUI) User Manual provides instructions for using the Event 

Capture options within the GUI setting. The target audience for this manual includes Event Capture 

managers, application coordinators (ADPACs) and other software users. 

The GUI provides a consistent, event-driven, Windows® style user interface for Event Capture. 

The Event Capture software provides a mechanism to track and account for procedures and delivered 

services that other Veterans Health Information Systems and Technology Architecture (VistA) packages 

do not handle. The procedures and services tracked through Event Capture are associated with the 

following: 

 The patient to whom they were delivered 

 The provider requesting the service or procedure 

 The DSS Unit responsible for delivering the service 

DSS Units typically represent the smallest identifiable work unit in a clinical service at a medical center. 

Veterans Affairs Medical Centers (VAMCs) define the DSS Units. A DSS Unit can represent any of the 

following: 

 An entire service 

 A section of a service 

 A small section within a section 

 A medical equipment item used in patient procedures 
The user must define the following items for every DSS Unit: 

 Service: The service associated with the DSS Unit 

 Cost Center: The fiscal identifier for the service using the particular DSS Unit (Cost Centers 
are defined in detail in the MP4-Part V Appendix B of the Fiscal Service Cost Manuals) 

 Medical Specialty: The specialty section associated with the DSS Unit 

1.1 Purpose 
The Event Capture GUI User Manual is intended for use as an instructional guide to using the Event 

Capture software. The user can use this manual in conjunction with the Event Capture GUI online help 

option. 

Screen displays may vary among different sites, and the data may not appear on the terminal exactly as 

shown in this manual. Although screens are subject to modification, the major menu options as they 

appear in this manual are fixed and are not subject to modification (except by the package developer). 

1.2 Document Orientation 

1.2.1 Organization of the Manual 

1.2.2 Assumptions 
This guide was written with the following assumed experience/skills of the audience: 

 User has basic knowledge of the operating system (such as the use of commands, menu 
options, and navigation tools). 
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 User has been provided the appropriate active roles, menus, and security keys required for the 
Event Capture System (ECS). 

 User is using ECS to do their job. 

 User has validated access to ECS. 

 User has completed any prerequisite training. 

1.2.3 Disclaimers 
The following disclaimers apply to all Department of Veterans Affairs (VA) user documentation. 

1.2.3.1 Software Disclaimer 

This software was developed at the VA by employees of the Federal Government in the course of their 

official duties. Pursuant to title 17 Section 105 of the United States Code, this software is not subject to 

copyright protection and is in the public domain. VA assumes no responsibility whatsoever for its use by 

other parties, and makes no guarantees, expressed or implied, about its quality, reliability, or any other 

characteristic. We would appreciate acknowledgement if the software is used. This software can be 

redistributed and/or modified freely provided that any derivative works bear some notice that they are 

derived from it, and any modified versions bear some notice that they have been modified. 

1.2.3.2 Documentation Disclaimer 

The appearance of external hyperlink references in this manual does not constitute endorsement by the 

VA of this website or the information, products, or services contained therein. The VA does not exercise 

any editorial control over the information you may find at these locations. Such links are provided and are 

consistent with the stated purpose of the VA. 

1.2.4 Documentation Conventions 

To avoid displaying sensitive information regarding our patients and staff, the examples in this manual 

contain pseudonyms or scrambled data instead of real names. Our patients and staff will be referred to as 

“ECPATIENT, ONE”, “AAECPROVIDER, ONE”, or “USER, ONE.” Scrambled data are a series of random 

letters that replace a real name like “AAADY, JWHTRE”. Likewise, real social security numbers (SSNs), 

real addresses, and other personal identifiers are not used. 

1.2.5 References and Resources 
The documentation for Event Capture v2.0 includes the following related manuals: 

 Event Capture Installation Guide 

 Event Capture Patch Description 

 Event Capture Technical Manual 

 Event Capture GUI Release Notes 

These documents can be found at on the VA Documentation Library (VDL) site. 

Patch information and documentation is also available online at the MCA Learning Community for Event 

Capture site. 

http://www.va.gov/vdl/application.asp?appid=39
http://vhaarcclb601.vha.med.va.gov/sites/dso/EventCapture/default.aspx
http://vhaarcclb601.vha.med.va.gov/sites/dso/EventCapture/default.aspx
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1.3 National Service Desk and Organizational Contacts 
The three tiers of support documented herein are intended to restore normal service operation as quickly 

as possible and minimize the adverse impact on business operations, ensuring that the best possible 

levels of service quality and availability are maintained. 

Table 1 lists organizational contacts needed by site users for troubleshooting purposes. Support contacts 

are listed by name of service responsible to fix the problem, description of the incident escalation, 

associated tier level, and contact information (email and phone number). 

Table 1. Tier Support Contact Information 

Name Role Org Contact Info 

Local ECS Package 
Manager 

Tier 0 Support VHA ECS Package Manager/Site Dependent 
http://vaww.dss.med.va.gov/dso/dso_list.asp  

Local MCA VISN 
Coordinator 

Tier 0 Support VHA Site Dependent 

http://vaww.dss.med.va.gov/dso/dso_list.asp  

OI&T National 
Service Desk 

Tier 1 Support OI&T Nationalservicedeskanr@va.gov 

1-855-673-4357 

http://vaww.itsupportservices.va.gov/anrhome.asp  

Health Product 
Support 

Tier 2 Support VHA Nationalservicedeskanr@va.gov 

1-855-673-4357 

http://vaww.itsupportservices.va.gov/anrhome.asp 

VistA Maintenance 
Management 
Systems 

Tier 3 
Application 
Support 

OI&T OITPDVistAMaintenanceManagementSystems@va.gov  

 

http://vaww.dss.med.va.gov/dso/dso_list.asp
http://vaww.dss.med.va.gov/dso/dso_list.asp
mailto:Nationalservicedeskanr@va.gov
http://vaww.itsupportservices.va.gov/anrhome.asp
mailto:Nationalservicedeskanr@va.gov
http://vaww.itsupportservices.va.gov/anrhome.asp
mailto:OITPDVistAMaintenanceManagementSystems@va.gov
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2 System Summary 

ECS is a VistA Class I workload reporting system supporting operations of the VA Managerial Cost 

Accounting Office (MCAO). There are several Veterans Health Administration (VHA) national programs 

mandating utilization of ECS in place of or to augment other workload capture information systems. For 

example, ECS is leveraged when programs cannot report workload in the form of Current Procedural 

Terminology (CPT) codes.  Other times, ECS allows for more precise workload capture and reporting 

than otherwise possible through another VistA system. 

Event Capture with all patches installed provides the following functions: 

 Allows each VAMC to utilize the software for its own resource/costing needs 

 Implements DSS Units 

 Assigns user access 

 Allows single and batch data entry for patient procedures 

 Generates reports for workload and other statistical tracking 

 Provides a graphical user interface to the ECS application 

 Allows user to upload patient encounter data to Event Capture from a spreadsheet 

 Allows user to switch between Computerized Patient Record System (CPRS) and ECS without 
having to log back into the EC GUI.exe 

2.1 System Configuration 
Please refer to the Event Capture Technical Manual for details related to system and site configuration. 

2.2 Data Flows 
Figure 1 demonstrates the ECS data flow. 

Figure 1: ECS Data Flow Diagram 

 

2.3 User Access Levels 
Security keys are assigned in VistA using the option Key Management main menu and then choosing the 

submenu Allocation of Security Keys. 

ECS provides the following security key options for user access: 
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 ECMGR: Gives a user access to the ECS Management Menu – only for Event Capture 
managers 

 ECALLU: Gives a user access to all DSS Units (super user).  This key should be assigned only 
to those managing the software (i.e., holders of the ECMGR key) 

 ECNORPT: Restricts the user from accessing Event Capture reports 

 ECSPSH: Gives a user access to upload data from a spreadsheet (required for State Home 
Spreadsheet upload) 

2.4 Continuity of Operations 
Each site has a backup emergency plan in place in the event that the system goes down. 

2.5 Section 508 Compliance 
Section 508 of the Rehabilitation Act Amendments of 1998 requires that when Federal agencies develop, 

procure, maintain, or use electronic and information technology, they shall ensure that the electronic and 

information technology enables persons with disabilities to have access to, and use of, information and 

data that is comparable to the access to and use of information and data by persons who are not 

individuals with disabilities, unless an undue burden would be imposed on the agency. 

The Section 508 Accessibility Testing and Training Center (T&TC) was consulted and modifications to the 

GUI have been made to meet the requirements for Section 508 compliance. Event Capture was modified 

to enable screen readers to accurately interpret information on the screens. As a result, some buttons 

and boxes have been moved, replaced or renamed, and some screen titles have been modified. 

For more information on the VA Section 508 compliance efforts, please visit the Section 508 website. 

 

http://www.section508.va.gov/index.asp
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3 Getting Started 

Event Capture must be set up by using the options in the Event Capture Management Menu before any 

data can be entered. Access to this menu should be restricted to the ADPAC and his or her designees. 

The Event Capture ADPAC should use the following steps as a guide for setting up the Event Capture 

software. 

  Select security keys. Step 1. 

 See Section 2.3 of this document for a description of ECS security keys. 

  Select required VistA settings. Step 2. 

 Users must be assigned the EC GUI CONTEXT VistA menu options in order for the ECS GUI 
to work. 

 Create an Event Capture Location. Step 3. 

 Create a location using the Location - Update Location Information option. 

Notes: 

 The selected location must be in the INSTITUTION file (#4). 

 At least one location must exist before DSS Units can be established. 

  Establish DSS Units for each service. Step 4. 

 Contact each service for a list of its DSS Units, the names of its Event Capture users and the 
DSS Units for which they will enter data, and for individual product resource tracking needs.  

 Use the DSS Unit - Add or Update DSS Units option to establish DSS Units for each service. 

Note: 

 At least one DSS Unit must exist before Event Code Screens can be created. 

  Assign user access to specific DSS Units. Step 5. 

 Use the Access by User - Grant Access to DSS Units by User option to assign user access to 
specific DSS Units for the users identified in Step 4.  

 Assign the ECALLU security key only to those users who should have access to all DSS Units. 

Notes: 

 Users must have access to DSS Units before they can begin entering data. 

 Use the Access by User – Grant Access to DSS Units by User option to remove user 
access for a specific DSS Unit.  Users with the ECALLU security key cannot be denied 
access to DSS Units. 

  Create Categories. Step 6. 

 Use the Category - Add or Update Categories option to create categories before the user sets 
up Event Code Screens. 

Notes: 

 Creating categories is optional. 

 After completion of this step, the Category Report option on the Reports Menu can be used 
to print a report of the site’s categories. 

  Create or edit local procedures in the EC NATIONAL PROCEDURE file (#725). Step 7. 
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 Use the Procedure - Add or Update Local Procedures option to enter new, or edit existing, local 
procedures in the EC NATIONAL PROCEDURE file (#725).  

 Adding local procedures is optional and not encouraged. 

Notes: 

 Before starting this step, use the National/Local Procedure Report option on the Reports 
Menu to print a list of procedures with their associated CPT codes. This report can be quite 
lengthy if it includes national procedures, so it should be queued to print to a device during 
non-peak hours. 

 An associated CPT code must be entered to pass local procedures to PCE. 

 Use this option to edit, but not delete, existing local procedures and to select an associated 
CPT code if this workload data should be sent to PCE. 

  Use the Event Code Screen - Add or Update Event Code Screens option to: Step 8. 

 Create an Event Code Screen for each procedure tracked in the Event Capture software.  

 Enter or edit an optional active associated clinic for DSS Units that are marked to send data to 
PCE. If an Associated Clinic has non-conforming stop codes, the clinic will not be selectable.  

 Enter or edit an optional procedure Synonym. 

 Set Ask Reasons? radio button to Yes or No. 

 Enter or edit procedure default Volume. 

Note: 

 An Event Code Screen for the procedure must be created before it can be used for data 
entry. 

  Optional: Print the Event Code Screens Sorted by DSS Units Step 9. 

 Use the Print Category and Procedure Summary (Report) option on the Reports Menu to print 
the Event Code Screens sorted by DSS Units. 

Notes: 

 Data entry clerks might find the output generated by this report useful as a procedure 
reference guide. 

  Event Capture set up is complete. Step 10. 

 Services can now enter data using the Data Entry options and provide summary reports using 
the Reports options. 

3.1 Logging On 
Event Capture is accessed through a desktop shortcut that points to the location of the EC GUI 

application. If the shortcut does not appear, refer to the Installation Guide for Event Capture, or ask the 

local support staff for assistance. 

Figure 2: ECS GUI Icon 

 

Double clicking the EC GUI shortcut will launch the application, and the VistA Sign-on screen will be 

displayed. Enter valid Access and Verify codes, then click the OK button. 
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Figure 3: VistA Sign-on Screen 

 

3.2 Event Capture Main Menu 
The Event Capture software contains four menus. The user must hold the ECSPSH security key to have 

access to the Spreadsheet option, and the ECMGR security key to have access to the Management 

Menu functions. Users without the ECMGR security key will have fewer reports available for selection 

than users with the ECMGR security key.  Users with the ECNORPT security key will not have access to 

the Reports option. 

The following Main Menu options display when the Event Capture GUI opens. 
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Figure 4: Main Menu for Event Capture 

 

Figure 5: Main Menu with the ECNORPT Security Key Added for the User 

 

3.2.1 Icon Shortcuts 
The icon shortcuts can be used to access options in Event Capture. 
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Figure 6: Icon Shortcuts 

 

3.2.2 Menu Bar 
The Event Capture menu bar enables the user to access shortcut commands. 

Figure 7: Main Menu Bar 

 

 The File menu item enables the user to Exit the application.  

 The Function menu item on the main window provides access to Data Entry, Spreadsheet (if 
the user has the proper security key), Reports and Management Menu functions.  

 The View menu item enables the user to show or hide the Toolbar and Status Bar.  

 The Help menu item provides topic-specific help, or information about the Event Capture 
system. 

Figure 8: Main Menu Bar with Menus Expanded 

 

3.3 Menu Bar for Specific Functions 
The menu bar functions are described in the subsections below. 

3.3.1 Data Entry Menu Bar 
The Data Entry menu bar consists of the File, Edit, View, and Help menus. 
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Figure 9: Data Entry Menu Options 

 

 The File menu item provides the option for the user to Exit the window.  

 The Edit menu item provides access to Data Entry by Patient, Data Entry by Procedure and 
Multiple/Multiple functions.  

 The View menu item enables the user to show or hide the Toolbar and Status Bar.  

 The Help menu item provides topic-specific help, or information about the Event Capture 
system. 

Figure 10: Data Entry with Menus Expanded 

 

3.3.2 Spreadsheet Menu Bar 

The Spreadsheet menu bar consists of the File, Edit, EC Upload, Spreadsheet Options (if the user has 

the proper security key), and Help menus. 

Figure 11: Spreadsheet Upload Options 

 

 The File menu item enables the user to Exit the window as well as Open Spreadsheet, Open 
State Home Spreadsheet, Close, Save, Save As and Print a file.  

 The Edit menu item provides access to Cut, Copy, Paste, Insert Row and Delete Row 
functions.  

 The EC Upload menu item enables the user to Upload Records to VistA.  

 The Spreadsheet Options menu item enables the user to Change Column Headers or Change 
Duplicate Threshold.  

 The Help menu item provides topic-specific help, or information about the Event Capture 
system. 
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Figure 12: Spreadsheet Menu with Menus Expanded 

 

3.3.3 Reports Menu Bar 
The Reports menu bar consists of the File, View, and Help menus. 

Figure 13: Reports Menu Bar 

 

 The File menu item enables the user to Exit the window.  

 The View menu item enables the user to show or hide the Toolbar and Status Bar.  

 The Help menu item provides topic-specific help, or information about the Event Capture 
system. 

Figure 14: Reports Menu with Menus Expanded 

 

3.3.4 Management Menu Bars 
The Management Menu bar consists of the File, Table, View, and Help menus. 

Figure 15: Management Menu Options 

 

 The File menu item enables the user to Exit the window.  

 The Table menu item provides access to Location, DSS Unit, Access by User, Category, 
Procedure, Reason, Event Code Screen and Inactivate EC Screen functions.  

 The View menu item enables the user to show or hide the Toolbar and Status Bar.  

 The Help menu item provides topic-specific help, or information about the Event Capture 
system. 
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Figure 16: Management Menu with Menus Expanded 

 

3.4 Changing User ID and Password 
To access ECS, users need a VistA Access Code and Verify Code. To change this, please contact the 

local Information Resource Manager (IRM). 

3.5 Exit System 
From the main Event Capture menu, click the Exit button to exit the Event Capture GUI. Alternatively, 

from the same screen, users can go to File > Exit, or click the Close window button in the top right corner 

of the screen. 

3.6 Caveats and Exceptions 
On all ECS GUI screens, the previous Location entry will be saved and used as the default on 

subsequent Location fields. 

3.7 Online Documentation 

Throughout the entire ECS GUI, click the question mark button located on the toolbar  or at the bottom 

right corner of the screen  to obtain online information for any screen. The information 

provided in the help menus corresponds to the information that is in this user manual. 

To obtain online information for a field, click on that field and then press the <F1> key. 
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Figure 17: Online Help Screen 

 

3.8 Event Capture Interface with CPRS 
The ECS GUI is accessible via CPRS. This design is intended to increase the use of Event Capture by 

clinicians currently using CPRS. The creation of a link and a single point of entry allow users to access 

both systems.  

The interface between CPRS and Event Capture enables users to: 

 Access Event Capture from within CPRS through a single sign-on. 

 Select Event Capture Interface in the CPRS Tool Menu allowing the user to enter Event 
Capture patient procedures. This requires set up by local IRM and/or the Clinical Application 
Coordinator. 

3.9 Timeout Feature 
Event Capture includes a timeout feature consistent with CPRS. A countdown screen will display a 

warning of the pending timeout of the application when the Event Capture application is idle for a user-

defined amount of time. If the user takes no action, the application will close. Click on the Do not close 

Event Capture button to stay connected. 

Figure 18: Event Capture Timeout Screen 

 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 15 

Patch EC*2.0*131 

 

The amount of time for the timeout and countdown features is user-defined at the application server level. 

3.10 CCOW Single Sign On 
Event Capture includes Clinical Context Object Workgroup (CCOW) Single Sign-on capability. If a user is 

signed onto another CCOW Single Sign-on enabled system, launching Event Capture will not require the 

user to re-enter system Access and Verify codes. The status of the CCOW single sign-on is shown via an 

icon on a panel in the upper right hand corner of the Main Menu. The hover help will display “Clinical Link 

On” if Event Capture was accessed via CCOW single sign-on, or “Clinical Link Off” if it was not. The icon 

on the panel is updated as well. 

Figure 19: Event Capture CCOW Status 
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4 Using the Software 

4.1 Data Entry Menu 
The Data Entry menu offers the following options: 

 Data Entry by Patient – Enter/Edit Patient Procedures 

 Data Entry by Procedure – Batch (Same Procedure, Multiple Patients) 

 Multiple Dates/Procs – Multiple Dates / Multiple Procedures 

Figure 20: Data Entry Menu Screen 

 

4.1.1 Data Entry by Patient 
Use the Data Entry by Patient option to: 

 Enter a single procedure for one patient 

 Edit an existing patient procedure 

 Delete an existing patient procedure 

Note:  

 Event Code Screens must be defined before entering any Event Capture data. 
 

Users will be presented with: 

 A summary screen to identify the Location, DSS Unit, Procedure Date Range, Patient Identifier 
and any existing procedures for that patient 

 A detail screen to show the detailed information about a selected patient procedure 
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Figure 21: Enter/Edit Patient Procedures Screen 

 

To use the Enter/Edit Patient Procedures screen: 

 Select a Location. Step 1. 

 If there is only one Location set up in ECS, the Location on the screen will default to that value. 

 If there is more than one Location set up in ECS, the Location on the screen will default to the 
last Location used. To change the Location, choose a Location from the dropdown list. 

  Select a DSS Unit. Step 2. 

 If one DSS Unit is defined in the Event Capture Management Menu for DSS Unit, or if only one 
DSS Unit is assigned to the user, that DSS Unit value will default. 

 If only one DSS Unit is assigned to the user, it will be the default selection. If more than one 
DSS Unit is assigned to the user, choose a DSS Unit from the dropdown list of accessible DSS 
Units. 

 The user can add, edit or delete any patient procedure for the selected DSS Unit. 

 To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add or 
Update DSS Units function to add the unit to the dropdown list. The ECMGR key is required. 

  Select a Date Range. Step 3. 

 The Procedure Date Range (from/through) will default to the system date. These fields may be 
edited by typing in a date (dd MMM yyyy) or by using the calendar dropdown. 

Note: 

 An edit check will prevent selecting a date in the future, or displaying a Procedures From 
date later than the Procedures Through date. 
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Figure 22: Calendar Dropdown for Date Range View 

 

  Use the Patient Identifier field to select a patient. Step 4. 

 Enter one of the following: 

– Patient Name (whole or partial, last name first) 

– Social Security Number 

– Last four digits of the Patient Social Security Number 

– First character of Last Name plus the last four digits of the SSN with no spaces 

 Click <Enter> or the Search button. 

 Choose from the list of patients displayed. 

  View the Patient Procedures. Step 5. 

 Once the previous steps are complete, the bottom section of the window will display the patient 
procedures in chronological order for the selected search criteria. Each record will display the 
Category, Procedure, Date/Time, Volume, Associated Clinic, Ordering Section, Primary 
Diagnosis and Primary Provider. 

Notes: 

 Click on the field header to sort the data in a different order. 

 The Close, Add and Topic Help buttons are always enabled. If patient procedures exist, the 
Update and Delete buttons will be enabled, as well. 

 Clicking on a row will highlight the patient procedure, effectively selecting that row as a 
candidate for updating or deleting. 
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Figure 23: Procedure History for Sample Patient 

 

  Complete data entry. Step 6. 

 Click the Add button to enter a new patient procedure. 

 Click the Update button to display the patient procedure on the Edit Patient Procedure Step 7. 
(Detail) screen. 

 Click the Delete button to delete the patient procedure from the file. Step 8. 

4.1.1.1 Recent Visits Screen 

To see the Recent Visits screen:  

 On the Enter/Edit Patient Procedures screen, click the Add button to enter a new patient Step 1. 
procedure. 

Notes: 

 The Add button will only display if the selected DSS Unit is set to send to PCE. 

 If recent visits exist, the Recent Visits screen will be displayed after clicking the Add button. 
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Figure 24: Recent Visits Screen 

 

 Selection options on the Recent Visits screen. Step 2. 

 On the Recent Visits screen, the user can choose one of three options: OK, Ignore or Cancel. 

– OK:  Select the appropriate Appointment/Encounter from the Recent Visits. Click the OK 
button to close the screen. The Add Patient Procedure screen will display with the 
Procedure Date/Time and Associated Clinic fields populated and not modifiable, based 
on the Appointment/Encounter selected on the Recent Visits screen. Enter the 
procedure(s), answer classification questions as they pertain to that visit, and enter 
diagnoses, provider, and other pertinent fields if required (reasons, ordering section 
and/or modifiers). 

– Ignore: Click the Ignore button on the Recent Visits screen to go to the Add Patient 
Procedure screen to enter information for all fields. 

– Cancel: Click the Cancel button to close the Recent Visits screen and return to the 
Enter/Edit Patient Procedures screen. 

Note: 

 If the Associated Clinic for the selected record is no longer active, clicking the OK button 
will result in the display of the Error: Invalid Associated Clinic message dialog.  The 
message dialog lists only active Associated Clinics. To update the record, select an active 
clinic from the list and then click the OK button. Click the Cancel button to open the record 
and the Associated Clinic field will be blank. 
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Figure 25: Error: Invalid Associated Clinic Message Dialog 

 

Figure 26: Add Patient Procedure Detail Screen 
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4.1.1.2 Add Information to the Add Patient Procedure or Edit 
Patient Procedure Screen 

To complete the Add Patient Procedure or Edit Patient Procedure screen: 

 Select a Category Step 1. 

 If the Allow Category Use field in the Add DSS Unit Management set up is set to NO, then the 
Category field will be blank and disabled. 

 If only one Category is defined for the specified DSS Unit, that Category will be the default 
value. 

 Select the Procedure Date and Time. Step 2. 

 This information is present if a recent visit was selected on the Recent Visits screen. 

 Typing “N” and then clicking <Enter> in the field (instead of clicking the  button) will bypass 
the dialog box, or clicking the Now button in the dialog box will enter the current system date 
and time. When the Midnight button is clicked, “23:59” is displayed for the time on the date 
selected. 

Figure 27: Select Date/Time Dialog Box 

 

 Select an Eligibility Code for this procedure. Step 3. 

 If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the 
Eligibility Code that applies to this procedure. 

 The primary Eligibility Code displays as the default. 

 Select a Procedure Name. Step 4. 

 Select a Procedure from the dropdown list. 

 Enter the Volume for the procedure. Step 5. 

 If applicable, the CPT Modifiers section will be enabled. Step 6. 

 Modifiers provide additional information about a CPT procedure. With functionality put in place 
by the Code Set Versioning project, only CPT modifiers that are active for the date and time of 
the event will show. 

 Choose a modifier from the Modifiers Available list and click Include. 

 Repeat as needed. 

 To remove a modifier, choose it from the Modifiers Selected list and click Exclude. 
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 Press <CTRL-Click> to select multiple modifiers at one time. 

 If applicable, the Reasons field will be enabled. Step 7. 

 The user can enter up to three reasons. 

 Reason #1 must be entered before a second or third may be entered. Reason #2 must be 
entered before a third may be entered. 

 Reasons appear alphabetically in the dropdown. 

 Once selected, a reason will not appear in the dropdown list for remaining reason fields. 

 A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason 
that appears is not the correct choice, click the down arrow on the reason dropdown to select 
another reason, or enter different letter(s). 

 If applicable, the mandatory classification questions section will be enabled. Step 8. 

 Select YES only if the treatment received relates to that classification. 

 Press the <F1> key while in the Service Connected field to display a message dialog containing 
the patient’s service connection and any rated disabilities. 

Figure 28: Service Connection and Rated Disabilities Screen 

 

 Select the Ordering Section. Step 9. 

 Select the Associated Clinic (if not already populated from the Recent Visits screen). Step 10. 

 Select the associated diagnosis code for the procedure. Step 11. 

 Use the Primary field to enter one of the following: 

– ICD code (whole or partial) 

– Diagnosis Name (whole or partial) 

 Click the Search button.  

 Select from the resulting dropdown list. 

 Repeat as needed to select the secondary diagnosis codes. 

 Select the providers of the services. Use the Providers Available text box to enter the Step 12. 
following: 

 Provider name (full or partial, last name first) 
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 Select the provider from the resulting dropdown list and click Include. 

 To remove a provider, select from the Providers Selected list and click Exclude.  

 Click the Add button to save the edited procedure and remain on the screen. Step 13. 

 Click the OK button to save the edited procedure and return to the Enter Patient Step 14. 
Procedure screen. 

 Click the Cancel button to return to the Enter Patient Procedure screen without saving Step 15. 
the above entries. 

Notes: 

 If the record transmits to PCE based on the DSS Unit on Management Menu set up, then 
all fields will be required. 

 If the record does not transmit to PCE based on the DSS Unit on Management Menu set 
up, then the Associated Clinic and the four Secondary Diagnosis fields will be disabled. 

 Press the <F1> key while in any field to open a dialog box displaying a help message. 

4.1.1.3 Add a Patient Procedure 

The following instructions and example assume that a user is entering a patient procedure for a specified 

patient and that the specified DSS Unit data transmits to PCE. 

 On the main Event Capture menu, select Data Entry. Step 1. 

 On the Data Entry Menu, select Data Entry by Patient. Step 2. 

 The Enter/Edit Patient Procedures screen appears.  

 Select the Location and DSS Unit. Step 3. 

 Allow the Procedure Date Range to default to today. Step 4. 

 Select a Patient. Step 5. 
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Figure 29: Enter/Edit Patient Procedures Screen 

 

 Click Add. Step 6. 

 If the DSS Unit is set to send to PCE, the Recent Visits screen will appear. Select a Step 7. 
scheduled appointment and click OK. 

Figure 30: Recent Visits Screen 
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 Complete the procedure-related fields on the Add Patient Procedure detail screen Step 8. 
according to the field-by-field instructions given in Section 4.1.1.2. 

Figure 31: Add Patient Procedure Screen 

 

 Click Add to save the record and clear the fields to add another procedure for this Step 9. 
patient. 

 Click the OK button to save the record and return to the Enter/Edit Patient Procedures Step 10. 
screen. 

 The Enter/Edit Patient Procedures screen will display any existing procedures for this Step 11. 
patient. 
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Figure 32: Enter/Edit Patient Procedures with New Procedure Added 

 

 Click Close to return to the Data Entry menu. Step 12. 

4.1.1.4 Edit a Patient Procedure 

 On the main Event Capture menu, select Data Entry. Step 1. 

 On the Data Entry Menu, select Data Entry by Patient. Step 2. 

 The Enter/Edit Patient Procedures screen appears. Step 3. 
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Figure 33: Enter/Edit Patient Procedures Screen 

 

 Select the Location and DSS Unit. Step 4. 

 Enter a Procedure Date Range by using the calendar dropdowns. The default is today. Step 5. 

 Select a patient. Step 6. 

 The lower portion of the screen will display the procedure(s) for the selected patient and Step 7. 
the DSS Unit within the date range. 

 Choose a procedure and click Update. Step 8. 

 The Edit Patient Procedure screen appears. Step 9. 
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Figure 34: Edit Patient Procedure Screen 

 

 Complete the procedure-related fields on the Edit Patient Procedure detail screen Step 10. 
according to the field-by-field instructions given in section 4.1.1. 

 Click Add to save the detail entries and open another detail screen for this patient. Step 11. 

 Click the OK button to save the detail entries and return to the Enter/Edit Patient Step 12. 
Procedures screen. 

 The Enter/Edit Patient Procedures screen will display the procedure(s) (Figure 32) Step 13. 
entered for this patient. 

 Click Close to return to the Data Entry menu. Step 14. 

4.1.1.5 Delete a Patient Procedure 

 On the main menu, select Data Entry. Step 1. 

 On the Data Entry Menu, select Data Entry by Patient. Step 2. 

 The Enter/Edit Patient Procedures summary screen appears. Step 3. 
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Figure 35: Enter/Edit Patient Procedures Screen 

 

 Select the Location and DSS Unit. Step 4. 

 Enter a procedure date range by using the calendar dropdowns. The default is today. Step 5. 

 Select a patient. Step 6. 

 The lower portion of the screen will display the procedure(s) for the selected patient and Step 7. 
the DSS Unit within the date range. 

 Choose a procedure and click Delete. Step 8. 

 A confirmation message appears.  Step 9. 

 Click the Yes button on the confirmation message dialog, and an Information message dialog 
appears to show the selected procedure was deleted for the patient. Click the OK button to 
return to the Enter/Edit Patient Procedures screen. 

 Click the No button on the confirmation message dialog to return to the Enter/Edit Patient 
Procedures screen without deleting the procedure. 

Figure 36: Procedure Deleted Confirmation Dialog 
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Figure 37: Confirmation Message 

 

 The screen will now refresh to show the remaining procedures entered for this patient. Step 10. 

Figure 38: Enter/Edit Patient Procedures Screen with Procedure Deleted 

 

 Click Close to return to the Data Entry menu. Step 11. 

4.1.2 Data Entry by Procedure 
Use the Data Entry by Procedure option to: 

 Enter/edit the same procedure for multiple patients 

Note:  

 Event Code screens must be defined before entering any Event Capture data. 
 

Users will be presented with: 
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 The left side of the screen contains information for the procedure that the system will use for all 
patients. (Note: The user will enter the procedure information only one time.) 

 The right side of the screen identifies each patient. The user will complete this section for each 
patient. Click Add to file the data, and clear the fields to enter data for the next patient. 

 The View button displays a listing of all patients entered for this procedure in this session. 

Figure 39: Same Procedure, Multiple Patients Screen 

 

4.1.2.1 Add a Procedure for Multiple Patients 

The following instructions and example assume that the user wants the specified DSS Unit to send data 

to PCE. 

 Select a Location. Step 1. 

 If there is only one Location set up for the Event Capture System, the Location on the screen 
will default to that value. 

 If there is more than one Event Capture Location set up, the Location will default to the last 
Location used. To change the Location, choose a Location from the dropdown list of available 
Event Capture Locations. 

 Select a DSS Unit. Step 2. 

 If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, 
that DSS Unit will be the default value. 
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 If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a 
dropdown list of accessible DSS Units. 

 The user can add, edit or delete any patient procedure for the selected DSS Unit. 

 To gain access to a DSS Unit, go the Management Menu and choose the DSS Unit - Add or 
Update DSS Units function to add the unit to the dropdown list. 

 Select a Category. Step 3. 

 If only one category is defined for the specified DSS Unit, that category will be the default. 

 Select the Procedure Date and Time. Step 4. 

 Typing “N” and then clicking <Enter> in the field (instead of clicking the  button) will bypass 
the date/time dialog, or clicking the Now button on the date/time dialog will enter the current 
system date and time. When the Midnight button is clicked, “23:59” is displayed for the time on 
the date selected. 

Figure 40: Select Date/Time Dialog 

 

 Select a Procedure Name. Step 5. 

 Select a procedure from the dropdown list. 

 If applicable, the Reasons field will be enabled.  Step 6. 

 The user can enter up to three reasons. 

 Reason #1 must be entered before a second or third may be entered. Reason #2 must be 
entered before a third may be entered. 

 Reasons appear alphabetically in the dropdown. 

 A reason will not appear in the dropdown list for remaining reason fields as an option once 
selected. 

 A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason 
that appears is not the correct choice, click the down arrow on the reason dropdown to select 
another reason or enter different letter(s). 

 If applicable, the CPT Modifiers section will be enabled. Step 7. 
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 Modifiers provide additional information about a CPT procedure. With functionality put in place 
by the Code Set Versioning project, only CPT modifiers that are active for the date and time of 
the event will show. 

 Choose a modifier from the Modifiers Available list and click the right pointer icon . Repeat 
as needed. 

 To remove a modifier, choose it from the Modifiers Selected list and click the left pointer icon 

.  

 Press <CTRL-Click> to select multiple modifiers at one time. 

 Select the providers of the services. Use the Providers Available text box to enter the Step 8. 
following: 

 Provider name (full or partial, last name first) 

 Select the provider from the resulting dropdown list and click the right pointer icon . 

 To remove a provider, select from the Providers Selected list and click the left pointer icon  

. 

 Use the Patient Identifier field to select a patient. Step 9. 

 Enter one of the following: 

– Patient Name (whole or partial, last name first) 

– Social Security Number 

– Last four digits of the Patient Social Security Number 

– First character of Last Name plus the last four digits of the SSN with no spaces 

 Click <Enter> or the Search button.  

 Choose from the list of patients displayed.  

 Select an Eligibility Code for this procedure. Step 10. 

 If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the 
Eligibility Code that applies to this procedure. 

 The primary Eligibility Code displays as the default. 

 Enter the Volume for the procedure. Step 11. 

 If applicable, the mandatory classification questions section will be enabled. Step 12. 

 Select YES only if the treatment received relates to that classification. 

 Pressing the <F1> key while in the Service-Connected field will open a message dialog 
displaying the patient’s service connection and any rated disabilities. 
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Figure 41: Service Connection and Rated Disabilities Dialog 

 

 Select the Ordering Section. Step 13. 

 Select an Associated Clinic for the specified DSS Unit, if applicable. Step 14. 

 Select the associated diagnosis code for the procedure. Step 15. 

 Use the Primary field to enter one of the following: 

– ICD code (whole or partial) 

– Diagnosis Name (whole or partial) 

 Click the Search button.  

 Select from the resulting dropdown list. 

 Repeat as needed to select the Secondary Diagnosis Codes. 

 Click the Add button to add this procedure for the patient. The right side of the screen Step 16. 
will reset to enter this procedure for another patient. Select the next patient for this 
procedure. Repeat the patient related steps above. 

 Click the OK button to add this procedure to the patient’s record and return to the Data Step 17. 
Entry menu. 

 Click the View button to verify that the list of patients entered is correct. The following Step 18. 
screen will list all of the patients entered for the procedure that was selected. 
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Figure 42: View Patients for this Procedure Screen 

 

 To correct an entry, return to the Data Entry menu and select Data Entry by Patient. Step 19. 

4.1.3 Multiple Dates / Multiple Procedures 
Use the Multiple Dates / Multiple Procedures option to: 

 Add multiple dates and multiple patients for multiple procedures. 

Notes: 

 Event Code screens must be defined before entering any Event Capture data. 

 Use the Data Entry by Patient option to make corrections to erroneous patient data. 

Users will be presented with: 

 An area at the top of the first screen for entering common fields (Location, DSS Unit and 
Category) as well as the Procedure Date/Time. 

 Three tabs for entering providers, procedures and patients. 

 Two tabs for checking work before submitting. 
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Figure 43: Multiple Dates/Multiple Procedures Screen – Initial Screen 

 

4.1.3.1 Instructions for Common Fields 

 Select a Location. Step 1. 

 If there is only one Location set up for the Event Capture System, the Location on the screen 
will default to that value. 

 If there is more than one Event Capture Location set up, the Location will default to the last 
Location used. To change the Location, choose a Location from the dropdown list of available 
Event Capture Locations. 

 Select a DSS Unit. Step 2. 

 If one DSS Unit is defined in Event Capture, or if only one DSS Unit is assigned to the user, 
that DSS Unit will be the default value. 

 If more than one DSS Unit is defined, a default will not be assigned. Choose a DSS Unit from a 
dropdown list of accessible DSS Units. 

 The user can add, edit or delete any patient procedure for the selected DSS Unit. 

 To gain access to an existing DSS Unit, go the Event Capture Manager must assign it to the 
user. 

 Select a Category. Step 3. 
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 If categories are not allowed in the DSS Unit, the selection box will be disabled. 

 If only one category is defined for the specified DSS Unit, that category will be the default. 

 Select the Procedure Dates and Time by using the Select Date/Time dialog. Step 4. 

Figure 44: Select Date/Time Dialog 

 

 Select date and time and click the OK button to close the dialog. 

 Click the Add Date/Time button to add the choice to the Selected Dates list. 

 Select and add dates as needed. 

 To remove a date, choose it from the list and click the Delete Date/Time button. 

Notes: 

 To bypass the Date/Time dialog, type “N” and press <Enter> in the field (instead of clicking 

the  button.) 

 To enter the current system date and time, click the Now button on the Date/Time dialog. 

 When the Midnight button is clicked, “23:59” is displayed for the time on the date selected. 

 Click and complete the tabs for Providers, Procedures and Select Patient as described in Step 5. 
Sections 4.1.3.2, 4.1.3.3, and 4.1.3.4. 

 Use the View Selected Patients and Records Pending Filing tabs to check the work as Step 6. 
described in Sections 4.1.3.5 and 4.1.3.6. 

 Click the Save button at the bottom of the screen to process the transactions shown on Step 7. 
the Records Pending Filing tab, and then redisplay the screen initialized for a new set of 
entries. 

 Click the OK button at the bottom of the screen to process the transactions shown on Step 8. 
the Records Pending Filing tab, and then return to the Data Entry menu. 

4.1.3.2 Add Information to Providers Tab 

 Click on the Providers tab to select one or more providers. Step 1. 
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Figure 45: Multiple Dates/Multiple Procedures Screen, Providers Tab 

 

 Select a Provider. Step 2. 

 Use the Providers Available list to enter the full or partial provider name (last name first) 

 Select the provider from the resulting dropdown list and click the Include button. 

 To remove a provider, select from the Providers Selected list and click the Exclude button. 

 Repeat as needed to add providers. Step 3. 

4.1.3.3 Add Information to Procedures Tab 

 Click on the Procedures tab to select one or more procedures. Step 1. 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 40 

Patch EC*2.0*131 

 

Figure 46: Multiple Dates/Multiple Procedures Screen, Procedures Tab 

 

 Select a Procedure Name. Step 2. 

 Select a procedure from dropdown list. 

 Enter the Volume for this procedure. Step 3. 

 If applicable, the Reasons field will be enabled. Step 4. 

 The user can enter up to three reasons. 

 Reason #1 must be entered before a second or third may be entered. Reason #2 must be 
entered before a third may be entered. 

 Reasons appear alphabetically in the dropdown. 

 A reason will not appear in the dropdown list for remaining reason fields as an option once 
selected. 

 A reason can be selected by entering the initial letter(s) into the Reasons field. If the reason 
that appears is not the correct choice, click the down arrow on the reason dropdown to select 
another reason or enter different letter(s). 

 If applicable, the Modifiers section will be enabled. Step 5. 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 41 

Patch EC*2.0*131 

 

 Modifiers provide additional information about a CPT procedure. With functionality put in place 
by the Code Set Versioning project, only CPT modifiers that are active for the date and time of 
the event will display. 

 Choose a Modifier from the Modifiers Available list and click the Include button. 

 Repeat as needed. 

 To remove a modifier, choose it from the Modifiers Selected list and click the Exclude button. 

 Click <CTL-Click> to select multiple modifiers at one time. 

 Click the Add Procedure button to add this procedure to the Procedures Selected list Step 6. 
and display a blank screen ready for another entry. 

 To add another procedure, repeat the steps above. Step 7. 

 To delete a procedure, choose it from the Selected Procedures list and click the Delete Step 8. 
Procedure button. 

 To view a procedure in an expanded format, choose it from the Selected Procedures list Step 9. 
and click the View Details button. The View Procedure Record Details screen is not 
editable. 

Figure 47: View Procedure Record Details Screen 

 

 Click the Close Procedure View button to return to the Procedures tab. Step 10. 

4.1.3.4 Add Information to Select Patient Tab 

 Click on the Select Patient tab to select one or more patients. Step 1. 
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Figure 48: Multiple Dates/Multiple Procedures Screen, Select Patient Tab 

 

 Use the Patient Identifier field to select a patient. Step 2. 

 Enter one of the following: 

– Patient Name (whole or partial, last name first) 

– Social Security Number 

– Last four digits of the patient Social Security Number 

– First character of Last Name plus the last four digits of the SSN with no spaces 

 Press <Enter> or click the Search button.  

 Choose from the list of patients displayed.  

 Select an Eligibility Code for this procedure. Step 3. 

 If the selected patient has only one Eligibility Code, that value defaults. Otherwise, select the 
Eligibility Code that applies to this procedure.  

 The primary Eligibility Code displays as the default. 

 If applicable, the mandatory Encounter Related classification questions section will be Step 4. 
enabled. 

 Select YES only if the treatment received relates to that classification. 
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 Pressing the <F1> key while in the Service-Connected field will open a message dialog 
displaying the patient’s service connection and any rated disabilities. 

Figure 49: Service Connection and Rated Disabilities Dialog 

 

 Select the Ordering Section. Step 5. 

 Select the Associated Clinic. Step 6. 

 Select the associated diagnosis code for the procedure. Step 7. 

 Use the Primary field to enter one of the following: 

– ICD code (whole or partial) 

– Diagnosis Name (whole or partial) 

 Click the Search button.  

 Select from the resulting dropdown list. 

 Repeat as needed to select the Secondary Diagnoses Codes. 

 Click the Add Patient button to add this patient to the list of Selected Patients and Step 8. 
display a blank screen ready for another entry. 

 Use the View Selected Patients tab to check the work. Step 9. 

4.1.3.5 Verify Information Using the View Selected Patients Tab 

 Click on the View Selected Patients tab to review the list of selected patients. Step 1. 
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Figure 50: Multiple Dates/Multiple Procedures View Selected Patients Tab 

 

 To remove a patient from the list, select record and click the Delete Patient button. Click Step 2. 
the Yes button on the Confirmation message dialog. 

Figure 51: Deleting Patient Confirmation Dialog 

 

 To view a patient in an expanded format, select the record and click the View Details Step 3. 
button. The patient record is not editable using the View Patient Record Detail screen. 
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Figure 52: View Patient Record Details Screen 

 

 Click the Close Patient View button to return to the View Selected Patients tab. Step 4. 

4.1.3.6 Verify Information Using the Records Pending Filing Tab 

 Click on the Records Pending Filing tab to view a list of the records to be filed.  Step 1. 

Note: 

 This screen is not editable. 
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Figure 53: Multiple Dates/Multiple Procedures Records Pending Filing Tab 

 

This screen lists the individual records (transactions) that will be processed when the OK or Save button 

at the bottom of the screen is clicked. An information dialog will appear on the screen to show the number 

of records added. 

Note: 

 Click the OK button to return to the Data Entry menu, or click Save to add more entries. 

Figure 54: Information Dialog after Saving 

  

The records consist of every combination of the dates, procedures, and patients selected on the tabs 

described in the preceding sections, and the providers selected will be assigned to each record. 

 To change the list, review and revise the selections on the Providers, Procedure and Step 2. 
Select Patient tabs and for the Selected Dates/Times field. 

 To correct an entry, return to the Data Entry menu and select Data Entry by Patient. Step 3. 
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4.2 Spreadsheet 
Data can be batch processed in the Event Capture GUI using the spreadsheet import and upload options.  

Two types of spreadsheet can be used for this data entry – the original “regular” spreadsheet, or the new 

State Home spreadsheet. Both methods of import are launched from the Spreadsheet Upload screen. 

Once a spreadsheet is imported into Event Capture, the data can be uploaded to VistA. 

The user will see a Spreadsheet Upload screen similar to the screenshot below. 

Figure 55: Spreadsheet Upload Screen 

 

4.2.1 Import a Regular Spreadsheet 

This is the traditional method for batch processing spreadsheet data that has been available since the 

inception of the Event Capture GUI. The spreadsheet import functionality works with MS Excel® files, as 

well as with tab or comma delimited files. All versions of Excel spreadsheets are compatible with this 

functionality. 

Notes: 

 A template with default column order is available to aid in populating spreadsheets prior to 
import.  The header row will not be processed when data are imported; therefore, it can 
remain in the spreadsheet during the import process. 

 The template is available on the VA EC Template.xlsx. 

 Once the template is downloaded, save it to a local hard drive for later use. 
Steps for importing a regular spreadsheet: 

http://vaww.dss.med.va.gov/programdocs/pd_clinictop.asp


 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 48 

Patch EC*2.0*131 

 

 Click the Open a Regular Spreadsheet button , or select the Open Spreadsheet Step 1. 
option from the File menu. A standard Select File dialog will be displayed, allowing the 
user to select the spreadsheet to be imported. 

Note: 

 Both *.XLS (pre- 2007) and *.XLSX versions of MS Excel spreadsheets are valid for use in 
the Event Capture spreadsheet import process. 

Figure 56: Select File Dialog - Open a Spreadsheet 

  

 Once the desired spreadsheet is selected for import, click the Open button. The data are Step 2. 
then imported into Event Capture, and will be displayed in the grid of the Spreadsheet 
Upload form. 

4.2.2 Data Imported and Ready for Upload 

Figure 57 is an example of the data that were imported from a spreadsheet into Event Capture. 
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Figure 57: Imported Spreadsheet Data Shown in the Spreadsheet Upload Form 

  

4.2.3 Edit Cell Data on the Spreadsheet Upload Form 

All imported data can be modified in the Spreadsheet Upload form. The information from the selected cell 

is displayed in the Cell Data edit box (located above the grid). The value can be changed in either the edit 

box or the cell itself. 

The contents of an individual cell can be deleted using either the Cell Data edit box, or by highlighting the 

cell and pressing the <Delete> key. 

To delete an ENTIRE RECORD, click once on a cell, then press the <Delete> key on the keyboard. 

Note: 

 Help is available for each column in the spreadsheet. Click on any column, and then click 

the Help button . 

4.2.4 Modify Column Order 

When the Spreadsheet Upload form is opened, the column headers are displayed in a default order. The 

user can change the order of the columns if the EC Template is not used.  

 Click the Column Header button , or select the Change Column Headers option from Step 1. 
the Spreadsheet Options menu. The Column Headers form (Figure 4.2-6) will be 
displayed. 
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Figure 58: Column Headers Form 

 

 To change the order of the columns, highlight the column heading from the list and click Step 2. 
either the Move Up or Move Down button.  

 Repeat step 2 until the column order matches the columns order of the spreadsheet. Click the 
Apply button to save the column order. 

Note: 

 The default column header order is as follows: 

 Record Num 

 Location 

 Pat SSN 

 Pat LName 

 Pat FName 

 DSS Unit Name 

 DSS Unit Num 

 DSS Unit IEN 

 Proc Code 

 Volume 

 Ordering Sect 

 Enc Date/Time 

 Category 

 Diag Code 

 Assoc Clinic Name 

 Assoc Clinic IEN 

 Mod 1 

 Mod 2 

 Mod 3 

 Mod 4 
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 Mod 5 

 Agent Orange 

 Ion Rad 

 Service Conn 

 SW Asia 

 Mil Sexual Trauma 

 Head Neck Cancer 

 Combat Vet 

 SHAD 

 Camp Lejeune (Note: As of Patch EC*2*131, this column is a placeholder) 

 Prov 1 Name or IEN 

 Prov 2 Name or IEN 

 Prov 3 Name or IEN 

 Prov 4 Name or IEN 

 Prov 5 Name or IEN 

 Prov 6 Name or IEN 

 Prov 7 Name or IEN 

4.2.5 Upload Imported Spreadsheet Data 

To start the upload process, click the Upload Records to VistA button  on the toolbar, or select the 

Upload Records to VistA option from the EC Upload menu. 

Each record in the imported spreadsheet is validated before being filed in the Event Capture Patient file 

(#721).  

Two levels of validation occur: 

1. The first level of validation occurs within the Event Capture GUI application. A check for required 

information is performed, and no data transmits to VistA if this level of validation fails for any 

record in the spreadsheet.  

2. The second level of validation occurs on the server side for each record in the spreadsheet.  

Records that pass this level of validation are filed in the EVENT CAPTURE PATIENT file (#721); 

records that fail this level of validation are not filed.  Records that are filed are removed from the 

spreadsheet grid, leaving only those records containing errors. Each of the remaining records in 

the spreadsheet will have its associated error message(s) displayed in the Error Messages box. 

The errored record(s) can then be edited before retransmitting, or deleted. 

Hint:  Click on an error message to highlight the cell in the grid that most likely caused the error. This will 

assist in identifying, and correcting, missing or invalid data. 

4.2.5.1 Spreadsheet Column Errors 

The following errors may display while uploading data into Event Capture via the Spreadsheet option: 

 Record Number:  When transmitting records, each row in the spreadsheet needs a unique 
record number (i.e. 1, 2, 3, etc.).  If this field is blank, VistA validation will not be done. 

– Delphi messages: 

 Error getting column with record number 

 Record number is a mandatory field 
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 Location:  The location number must exist on the INSTITUTION file (#4) (also known as 
^DIC(4,D0,0), where D0 is the location number). 

– VistA message: 

 Location not on INSTITUTION file (#4) 

 Pat SSN:  The Patient SSN must exist on the PATIENT file (#2) (also known as global file 
^DPT).  If the SSN is shorter than 9 digits, it will be filled with leading zeroes.  Do not use 
dashes in the SSN. 

– VistA messages: 

 No SSN x-ref on PATIENT file (#2) 

 No SSN entry on PATIENT file (#2) 

 No internal entry on PATIENT file (#2) for SSN x-ref 

 SSN does not match SSN on PATIENT file (#2) 

 Patient LName and Patient FName:  The patient’s name (last name, first name) must match the 
name on the PATIENT file (#2) for that SSN. 

– Delphi messages: 

 Error getting column with Patient LName 

 Patient LName must be at least 2 characters long 

– VistA messages: 

 Patient last name does not match VistA 

 Patient first name does not match VistA 

 DSS Unit Name:  If this field contains a value, then it must have a “B” cross-reference on the 
DSS UNIT file (#724). The DSS Unit Name is not required if either the DSS Unit Number or the 
DSS Unit IEN contains a value. 

– VistA message: 

 Invalid DSS Unit Name 

 DSS Unit Number:  This is the Unit Number, found on the DSS UNIT file (#724). If this field 
contains a value, then it must have a “C” cross-reference on the DSS UNIT file (#724). The 
DSS Unit Number is not required if either the DSS Unit Name or the DSS Unit IEN contains a 
value. 

– VistA message 

 Invalid DSS Unit Number 

 DSS Unit IEN:  If this field contains a value, then it must exist on the DSS UNIT file (#724). The 
DSS Unit IEN is not required if either the DSS Unit Name or the DSS Unit Number contains a 
value. 

– VistA message 

 Invalid DSS Unit IEN 

 Proc Code:  This is the Procedure or the CPT code value (not the description). A National 
Procedure, Local Procedure or CPT code is valid for this column. Either the Procedure must 
exist in the EC NATIONAL PROCEDURE file (#725), or the CPT must exist in the CPT file 
(#81). In addition, the Event Code Screen must be active for the Location, DSS Unit IEN, and 
Procedure/CPT combination. With functionality put in place by the Code Set Versioning project, 
only CPT codes that are active for the date and time of the event are processed. 

– VistA messages 

 Procedure or “D” x-ref not on EC NATIONAL PROCEDURE file (#725) 
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 Procedure invalid for this Location and DSS Unit 

 Unable to check for active EC Event Code Screen 

 Volume:  The volume must be a number from 1 through 99. 

– Delphi error messages 

 Error getting column with Volume number 

 Volume is a mandatory field 

 Volume has a limit of 2 digits 

– VistA messages 

 Volume must be a number from 1 to 99 

 Volume must contain numeric characters only 

 Ordering Section:  This is the name of the Ordering Section. Validation (against the “B” cross-
reference in the MEDICAL SPECIALTY file (#723)) occurs for Ordering Section values used in 
the spreadsheet. If this field is blank, the program will derive the Ordering Section from the DSS 
UNIT file (#724) using the DSS Unit IEN. The record will then be transmitted to the Event 
Capture filer program. 

– VistA message 

 Invalid Ordering Section 

 Unable to determine Ordering Section 

 Prov Name or IEN:  This is the Provider’s last and first name as it appears in the “B” cross-
reference of the NEW PERSON file (#200). If the provider also has a middle initial, then it 
should be included (e.g. ‘ECPROVIDER, SEVEN J’). If the system finds a partial match for the 
name, the application will return the provider information (provider name, IEN, specialty, 
subspecialty, person class), and the user can then determine which provider is correct. The 
Provider Name must have a “B” cross-reference in the NEW PERSON file (#200), and the 
person class must be active. 

– VistA messages 

 Provider has no B x-ref on NEW PERSON file (#200) 

 Unable to determine person class 

 Provider does not have an active person class 

 Enc Date/Time:  The Encounter Date/Time can be in any valid FileMan format. 
 

 Examples: 

 mm/dd/yy @hh:mm 

 mm/dd/yyyy @hh:mm 

 mm-dd-yy @hh:mm 

 mmddyy @hhmm 

 N, N-1, N-1H, etc. 

– VistA message 

 Invalid encounter date/time 

 Category:  The Category field can be blank. If the user enters a value, it needs to have a “B” 
cross-reference in the EC CATEGORY file (#726). 

– VistA message 

 Category “B” x-ref not on EC CATEGORY file (#726) 
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 Diag Code:  This is the primary Diagnosis Code value. It must exist on the ICD DIAGNOSIS file 
(#80). With functionality put in place by the Code Set Versioning project, only ICD codes that 
are active for the date and time of the event process are valid. The Diagnosis Code is only 
required for records sent to PCE. The system ignores it otherwise. 

– VistA messages 

 Diagnosis code is required for this DSS Unit 

 Unable to retrieve Diagnosis IEN 

 Assoc Clinic:  This is the Associated Clinic name. It must have a “B” cross-reference on the 
HOSPITAL LOCATION file (#44), be of type “C” (clinic), and be active for that encounter date. 
The Associated Clinic must have conforming stop codes to be selectable. The Associated Clinic 
is only required for records sent to PCE; otherwise, it will be ignored. 

– VistA messages 

 Associated Clinic is required for this DSS Unit 

 Assoc Clin “B” x-ref not found on HOSPITAL LOCATION file (#44) 

 Assoc Clin not found on HOSPITAL LOCATION file (#44) 

 Associated Clinic must be of type "C" (clinic) 

 Associated Clinic inactive for this encounter date 

 Modifier (1 through 5):  This is the Modifier, or Modifiers, associated with the procedure. 

– VistA message 

– Modifier is invalid or duplicated for the selected procedure 

4.2.5.2 Service Connected Questions Validation 

The Service Connected (SC) classification data validation and requirements are similar to those for 

records entered using other ECS data entry options. In order to assist the user in gathering SC 

information, Event Capture generates a spreadsheet of SC-related deficiencies found when transmitting 

the data. When a row fails validation because of SC-related deficiencies, an Export SC Errors button will 

appear above the Error Messages box. Click the button to generate an Excel spreadsheet, which the user 

can then save, print, or email to help resolve the errors. 

Figure 59: Connected Error Message and Export SC Errors Button 

 

Figure 60: Export SC Errors Spreadsheet 

 

4.2.5.3 Other Error Correction Logic 

 DSS Unit IEN:  The system obtains the DSS Unit IEN by checking the DSS Unit IEN, the DSS 
Unit Number and the DSS Unit Name fields. If any of the three contain erroneous data, an error 
message is displayed and the record is not filed. 
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 Send to PCE:  Using the DSS Unit, the application determines if the record transmits to PCE. If 
the DSS Unit is set to send to PCE, the application then validates the Associated Clinic and 
Diagnosis Code. If the DSS Unit is not set to send to PCE, the system ignores these two 
columns. 

4.2.5.4 Duplicate Record Errors 

If the system detects duplicate records when the spreadsheet uploads, a File Duplicate Record(s) 

checkbox appears on the screen.  The duplicate records display in the Error Messages box. Checking the 

File Duplicate Record(s) box and retransmitting the spreadsheet files the duplicate records in the Event 

Capture Patient file (#721). 

If the user-defined threshold of duplicate records is reached, a screen is displayed with the options to 

continue processing the records, change the threshold, or abort the upload. 

Figure 61: Duplicate Record Threshold Reached Screen 

 

 Continue:  Resets the counter and resumes processing records. 

 Change:  Allows the user to change the duplicate record threshold. 

 This threshold can also be altered prior to starting the upload process by selecting the Change 
Duplicate Threshold option from the Spreadsheet Options menu. 

 Abort:  Terminates the upload process. 

4.2.6 Import a State Home Spreadsheet 
State Home facilities use Excel spreadsheets for tracking patient occupancy. The State Home 

spreadsheet template is available for download from the State Home website 

(http://nonvacare.hac.med.va.gov/programs/state-homes-tools.asp). Event Capture can directly import, 

and upload, the data from these spreadsheets. 

Steps for importing a State Home Spreadsheet: 

Click the Open a State Home Spreadsheet button , or select the Open State Home Step 1. 
Spreadsheet option from the File menu. A standard Select File dialog will be displayed, 
allowing the user to select the State Home spreadsheet to be imported. 

http://nonvacare.hac.med.va.gov/programs/state-homes-tools.asp
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Figure 62: Select File Dialog - Open a State Home Spreadsheet 

 

Note: 

 Multiple months of State Home data can be stored in a single spreadsheet by using tabbed 
worksheets to represent the various months.  Only the worksheet that was active when the 
spreadsheet was last saved will be imported. 

 Once the desired State Home spreadsheet is selected for import, click the Open button. Step 2. 

 A screen prompting the user for more information, including Facility Type, Location, Step 3. 
DSS Unit, Date and Provider(s), is displayed. 

Figure 63: Additional Data Form for State Home Spreadsheet Import 
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Notes: 

 All fields must contain data in order to import a State Home spreadsheet. 

 Click the Cancel button on this screen to abort the import process. 

 Click the OK button on this screen to continue with the import. The data are then Step 4. 
imported into Event Capture, and will be displayed in the grid of the Spreadsheet Upload 
form. 

4.2.7 Upload Completion 
As records are processed, the uploaded rows will be cleared from the data grid, and a progress indicator 

will display the number of rows uploaded and the number records in error. When all rows have been 

uploaded, both the data grid and the Error Messages list will be clear of all records. 

Figure 64: Spreadsheet Upload Progress Indicator 

 

4.3 Reports 
The following subsections describe the reports available within Event Capture. 

4.3.1 Reports Available to All Users 

The following reports are available to all users (including ECMGR key holders): 

 DSS Unit Activity Report 

 DSS Unit Workload Report 

 ECS Records Failing Transmission to PCE Report 

 Event Capture Encounters Report 

 Ordering Section Summary Report  

 Patient Summary Report 

 PCE Data Summary Report 

 Procedure Reasons Report 
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 Provider Summary Report 

 Provider (1-7) Summary Report 

Figure 65: Report Selection Screen for All Users 

 

4.3.1.1 DSS Unit Activity Report 

 The report can be sorted by patient, provider or SSN. 

 If more than one location has been set up, choose one or all locations. 

 After previewing the report, the user will have the option to print or close the report. 

 Enter a date range. Step 1. 

 Select one or all Location(s). Step 2. 

 Select one or all DSS Unit(s). Step 3. 

 Choose Sort Method (Patient, Provider or SSN) for the report. Step 4. 

Notes: 

 Only the last four digits of the patient’s SSN will appear on the print preview of this report. 

 The column order does not change with Sort Method when exported into Excel. 

 Export, Preview, Print or Cancel the report. Step 5. 
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Figure 66: DSS Unit Activity Report Required Information 

 

Figure 67: DSS Unit Activity Report from Print Preview 
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Figure 68: DSS Unit Activity Report from Export 

 

4.3.1.2 DSS Unit Workload Report 

 With functionality put in place by the Code Set Versioning project, CPT codes, five-character 
EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred 

 After previewing the report, the user will have the option to print or close the report. 

 Enter a date range. Step 1. 

 Select one or all location(s). Step 2. 

 Select one or all DSS Unit(s). Step 3. 

 Export, Preview, Print or Cancel the report. Step 4. 

Figure 69: Required Information for DSS Unit Workload Report 
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Figure 70: DSS Unit Workload Report from Print Preview 

 

Figure 71: DSS Unit Workload Report from Export 

 

4.3.1.3 ECS Records Failing Transmission to PCE Report 

 Locations, DSS Units, procedures, five-character EC National Codes (when applicable) and 
categories must be defined before using this option. 

 After previewing the report, the user has the option to print or close the report. 

 Select the date range. Step 1. 

 Export, Preview, Print or Cancel the report. Step 2. 
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Figure 72: ECS Records Failing Transmission to PCE Report Required Fields 

 

Figure 73: ECS Records Failing Transmission to PCE Report from Print Preview 
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Figure 74: ECS Records Failing Transmission to PCE Report from Export 

 

4.3.1.4 Event Capture Encounters Report 

 Displays and counts the unique occurrences by patient and DSS Unit during a selected date 
range. It also enables sorting by patient or by provider. 

– When sorted by Patient shows the number of unique occurrences for the Patient across 
the date range that is selected.  

– When sorted by Provider shows the number of unique occurrences for the Provider 
across the date range that is selected. 

 Includes the fields Patient Name, SSN (last 4 digits), Inpatient or Outpatient (I/O), Date/Time, 
Provider #1, DSS Unit and Volume. 

 After previewing the report, the user has the option to print or close the report. 

 Select a date range. Step 1. 

 Select a Location. Step 2. 

 Select one, all or multiple DSS Unit(s). Step 3. 

 Select Sort Method (Patient or Provider). Step 4. 

 Export, Preview, Print or Cancel the report. Step 5. 

Notes: 

 Only the last four digits of the patient’s SSN will appear on the print preview of this report. 

 The column order does not change with Sort Method when exported into Excel. 

 A report timeout warning and a message dialog are displayed when All Locations, All DSS 
units or large date ranges are selected.  
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Figure 75: Event Capture Encounters Report Required Fields 

 

Figure 76: Event Capture Encounters Report Timeout Warning 
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Figure 77: Event Capture Encounters Report Sorted by Patient 

 

Figure 78: Event Capture Encounters Report Sorted by Provider 

 

Figure 79: Event Capture Encounters Report from Export 
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4.3.1.5 Ordering Section Summary Report 

 The design of this report is for a 132-column format. 

 With functionality put in place by the Code Set Versioning project, CPT codes, five-character 
EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred. 

 After previewing the report, the user will have the option to print or close the report. 

 Enter a date range. Step 1. 

 Select an Ordering Section. Step 2. 

 Select a specific or all Location(s). Step 3. 

 Select one, multiple, or all DSS Unit(s). Step 4. 

 Export, Preview, Print or Cancel the report. Step 5. 

Figure 80: Ordering Section Summary Report Required Information 
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Figure 81: Ordering Section Summary Report from Print Preview 

 

Figure 82: Ordering Section Summary Report from Export 

 

4.3.1.6 Patient Summary Report 

 The design of this report is for a 132-column format. 

 With functionality put in place by the Code Set Versioning project, CPT codes, five-character 
EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred.  

 The user can choose to include Procedure Reasons (EVENT CAPTURE PATIENT file (#721)) 
on the report. Up to three reasons will be included. 

 The “Display Reasons on this report” will clear when the user selects another report or upon 
exiting the screen. 

 After previewing the report, the user will have the option to print or close the report. 

 Enter a date range. Step 1. 

 Use the Patient Identifier field to select a patient. Step 2. 
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 Enter one of the following: 

– Patient Name (whole or partial, last name first) 

– Social Security Number 

– Last four digits of the Patient Social Security Number 

– First character of Last Name plus the last four digits of the SSN with no spaces 

 Press <Enter> on the keyboard or click the Search button.   

 Choose from the list of patients displayed. 

 Click the Display Reasons on this report checkbox to include Procedure Reasons in the Step 3. 
report. 

 Export, Preview, Print or Cancel the report.  Step 4. 

Figure 83: Patient Summary Report Required Information without Reasons 
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Figure 84: Patient Summary Report from Report Preview without Reasons 

 

Figure 85: Patient Summary Report from Export without Reasons 
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Figure 86: Patient Summary Report Required Information with Reasons  

 

Figure 87: Patient Summary Report from Report Preview with Reasons 
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Figure 88: Patient Summary Report from Export with Reasons 

 

4.3.1.7 PCE Data Summary Report 

 The design of this report is for a 132-column format. 

 With functionality put in place by the Code Set Versioning project, CPT codes, five-character 
EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated 
descriptions are reflective of the date the event occurred.  

 After previewing the report, the user has the option to print or close the report. 

 Enter a date range. Step 1. 

 Use the Patient Identifier field to select a patient. Step 2. 

 Enter one of the following: 

– Patient Name (whole or partial, last name first) 

– Social Security Number 

– Last four digits of the Patient Social Security Number 

– First character of Last Name plus the last four digits of the SSN with no spaces 

 Press <Enter> on the keyboard or click the Search button.   

 Choose from the list of patients displayed. 

 Export, Preview, Print or Cancel the report. Step 3. 
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Figure 89: PCE Data Summary Report Required Information 

 

Figure 90: PCE Data Summary Report from Print Preview 
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Figure 91: PCE Data Summary Report from Export 

 

4.3.1.8 Procedure Reasons Report 

 Locations, DSS Units, procedures, and procedure reasons must be defined before using this 
option. 

 With functionality put in place by the Code Set Versioning project, CPT codes, five-character 
EC National Codes (when applicable), CPT modifiers, diagnosis codes and their associated 
descriptions are reflective of the date the event occurred. 

 After previewing the report, the user has the option to print or close the report. 

 This report is exportable into an Excel spreadsheet. The tab in Excel is titled “Reasons” 
followed by the Date Range the user selected. 

 Select a date range. Step 1. 

 Select one, all or multiple Location(s). Step 2. 

 Select one, all or multiple Procedure Reasons. Step 3. 

 Select one, all or multiple DSS Unit(s). Step 4. 

 Export, Preview, Print or Cancel the report. Step 5. 
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Figure 92: Procedure Reasons Report Required Information 

 

Figure 93: Procedure Reasons Report from Print Reviews 
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Figure 94: Procedure Reasons Report from Export 

 

4.3.1.9 Provider Summary Report 

 Locations, DSS Units, categories, procedures and procedure reasons must be defined before 
generating this report. 

 If Procedure Reason #1 is not listed, the report prints “Reason Not Defined”. 

 With functionality put in place by the Code Set Versioning project, CPT codes, five-character 
EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred. 

 After previewing the report, the user will have the option to print or close the report. 

 Enter a date range. Step 1. 

 Select one or all Location(s). Step 2. 

 Select one or all DSS Unit(s).  Step 3. 

 Export, Preview, Print or Cancel the report. Step 4. 

Figure 95: Provider Summary Report Required Information 
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Figure 96: Provider Summary Report from Print Preview 

 

Figure 97: Provider Summary Report from Export 

 

4.3.1.10 Provider (1-7) Summary Report 

 The design of this report is for a 132-column format. 

 With functionality put in place by the Code Set Versioning project, CPT codes, five-character 
EC National Codes (when applicable), CPT modifiers and their associated descriptions are 
reflective of the date the event occurred. 

 This report provides the ability to view up to seven provider numbers for providers within a 
Location/DSS Unit. 

 Summarizes the workload of providers for a selected date showing how many times a specific 
procedure was performed on a patient with the selected provider as Provider 1, Provider 2, 
through Provider 7. 

 After previewing the report, the user has the option to print or close the report. 

 Enter a date range. Step 1. 

 Enter the name of a Provider. Step 2. 

 Export, Preview, Print or Cancel the report. Step 3. 
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Figure 98: Provider (1-7) Summary Report Required Information 

 

Figure 99: Summary Report from Print Preview 
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Figure 100: Provider (1-7) Summary Report from Export 

 

4.3.2 Reports Available to ECMGR Key Holders Only 

The following reports are available only to ECMGR key holders: 

 Category Report 

 Disabled Category and Procedure Summary 

 DSS Units with any Associated Stop Code Errors  

 DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 

 DSS Unit Users Access Report 

 Event Code Screens with CPT Codes Report 

 Event Code Screens with Inactive Default Associated Clinic 

 Inactive Person Class Report (IPC) 

 National / Local Procedure Codes with Inactive CPT Codes 

 National / Local Procedure Report 

 Print Category and Procedure Summary (Report) 

 Send No Records DSS Units Report 

As shown in the figure below, ECMGR reports are displayed in the Select Report area, below the asterisk 

line. 
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Figure 101: Report Selection Screen for ECMGR Key Holders 

 

4.3.2.1 Category Report 

 Use the Category - Add or Update Categories option to create categories before selecting this 
report. 

 This report is accessible to Management users only. This report will not appear for users 
without the management security key (ECMGR). 

 After previewing the report, the user has the option to print or close the report. 

 Choose a status of Active, Inactive or Both. Step 1. 

 Export, Preview, Print or Cancel the report. Step 2. 
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Figure 102: Category Report Required Fields 

 

Figure 103: Category Report (Active) from Print Preview 
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Figure 104: Category Report (Active) from Export 

 

Figure 105: Category Report (Inactive) from Print Preview 

 

Figure 106: Category Report (Inactive) from Export 
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Figure 107: Category Report (Both Active and Inactive) from Print Preview 

 

Figure 108: Category Report (Both Active and Inactive) from Export 

 

4.3.2.2 Disabled Category and Procedure Summary  

 This report is accessible to Management users only. This report will not appear for users 
without the management security key (ECMGR). 

 This report provides a list of ECS categories that have been disabled for one or all DSS Units 
for a specified location.  Event Code Screens that are comprised of DSS Units that allow 
category use, and have Event Code Screens defined using the disabled category, will appear 
on this report. 

 The report provides the Location, Service, DSS Unit IEN and name, Send Status and DSS 
Dept. 

 The exported data will include those fields listed above, as well as the DSS Unit Inactive, 
Disabled Category, CPT Code, Procedure Code, Procedure Name, Synonym, Clinic IEN, 
Clinic, Clinic Stop Code, Credit Stop Code and CHAR4 Code. 

 After previewing the report, the user has the option to print or close the report. 

 Select the report. Step 1. 

 Select All Locations, One Location, or Multiple Locations.  Step 2. 

 Export, Preview, Print or Cancel the report. Step 3. 
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Figure 109: Disabled Category and Procedure Summary Required Fields 
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Figure 110: Disabled Category and Procedure Summary 

  

Figure 111: Disabled Category and Procedure Summary from Export 

 

4.3.2.3 DSS Units with Any Associated Stop Code Errors Report 

 This report is accessible to Management users only. This report will not appear for users 
without the management security key (ECMGR). 

 The Event Capture software restricts DSS-only workload to use valid Stop Codes.  
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 To assist sites in locating DSS Units that have invalid associated Stop Codes, the DSS Unit list 
with Secondary Associated Stop Codes option is provided. This may be attached as a 
secondary menu option and run as often as needed. The only prompt is for Device.  

 This report provides a list of DSS Units with any error with the Associated Stop Code. 

 The report provides the DSS Unit IEN and name, Associated Stop Code IEN and name and the 
reason for the error. 

 After previewing the report, the user has the option to print or close the report. 

 Select an active non-secondary Stop Code to replace the Stop Code in the DSS Unit set up. 

 Select the report.  Step 1. 

 Export, Preview, Print or Cancel the report. Step 2. 

Figure 112: DSS Units with Any Associated Stop Code Errors Required Fields 
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Figure 113: DSS Units with Any Associated Stop Code Errors 

 

Figure 114: DSS Units with Any Associated Stop Code Errors from Export 

 

4.3.2.4 DSS Units/Event Code (EC) Screens for Selected 
Procedure Code Report 

 Only holders of the ECMGR security key can run this report. 

 After previewing the report, the user has the option to print or close the report. 

 This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “Selected 
Procedure Code”. 

 Select one, all or multiple Location(s). Step 1. 

 Select a Procedure. Step 2. 

 Export, Preview, Print or Cancel the report. Step 3. 
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Figure 115: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report 

  

Figure 116: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from Print 
Preview 
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Figure 117: DSS Units/Event Code (EC) Screens for Selected Procedure Code Report from Export 

 

4.3.2.5 DSS Unit User Access Report 

 This report is also accessible from the Grant Users Access menu option. 

 After previewing the report, the user has the option to print or close the report. 

 This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “DSS Unit 
User Access Report”. 

 Select a Location. Step 1. 

 Select one, all or multiple DSS Units. Step 2. 

 Export, Preview, Print or Cancel the report. Step 3. 

Figure 118: DSS Unit User Access Report Required Fields 
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Figure 119: DSS Unit User Access Report from Print Preview 

  

Figure 120: DSS Unit User Access Report from Export 

 

4.3.2.6 Event Code Screens with CPT Codes Report 

 Users can print, preview or export Event Code Screens with active and/or inactive CPT codes 
for one or all DSS Unit(s).  

– For previewing or printing the report, when Both is selected for Active and Inactive CPT 
codes, all inactive CPT codes are flagged with an *I* indicator. 

– For exporting the report, all Inactive CPT codes are flagged with an **Inactive** indicator. 

 Users must have the Management Security ECMGR key to access this report. 

 After previewing the report, the user has the option to print or close the report. 

 Select one or all Location(s). Step 1. 

 Select one or all DSS Unit(s). Step 2. 

Note: 

 If All is selected for the DSS Unit, the Category will also be All and will be disabled. 

 Select a Category. Step 3. 

Note:  

 Categories only appear if the Event Code Screen uses categories to group procedures. 

 Select Active, Inactive or Both (Active and Inactive) for CPT Codes. Step 4. 

 Export, Preview, Print or Cancel the report. Step 5. 

Note:  

 The tab of the report indicates whether the exported report shows only active, only inactive, 
or both active and inactive CPT codes. 
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Figure 121: Event Code Screens with CPT Codes Report Required Fields 

  

Figure 122: Event Code Screens with CPT Codes Report from Print Preview  
(Both Active and Inactive CPT Codes Selected) 

 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 91 

Patch EC*2.0*131 

 

Figure 123: Event Code Screens with CPT Codes Report from Export 

 

The tab of the report above indicates that the report is “Showing only Inactive CPT Codes”. 

4.3.2.7 Event Code Screens with Inactive Default Associated Clinic 
Report 

 Only holders of the ECMGR security key can run this report. 

 After previewing the report, the user has the option to print or close the report. 

 This report is now exportable into an Excel spreadsheet. The tab in Excel is titled “Inactive 
Default Clinic”. 

 Select one, all or multiple Location(s). Step 1. 

 Select one, all or multiple DSS Unit(s). Step 2. 

 Export, Preview, Print or Cancel the report. Step 3. 

Figure 124: Event Code Screens with Inactive Default Associated Clinic 
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Figure 125: Event Code Screens with Inactive Default Associated Clinic from Print Preview 

 

Figure 126: Event Code Screens with Inactive Default Associated Clinic from Export 

 

4.3.2.8 Inactive Person Class Report (IPC) Report 

 This report shows providers who do not have a Person Class specified in the NEW PERSON 
file (#200) or who do not have an active Person Class in the NEW PERSON file (#200) for the 
date of the procedure. 

 After previewing the report, the user has the option to print or close the report. 

 Enter a date range. Step 1. 

 Select Sort by Patient or Sort by Procedure. Step 2. 

 Export, Preview, Print or Cancel the report. Step 3. 

Note:  

 The column order does not change with Sort Method when exported into Excel. 
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Figure 127: Inactive Person Class Report Required Information 
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Figure 128: Inactive Person Class Report from Print Preview 

  

Figure 129: Inactive Person Class Report from Export 

 

4.3.2.9 National/Local Procedure Codes with Inactive CPT Codes 
Report 

 This report provides a list of National and Local Procedure Codes with inactive CPT codes from 
EC NATIONAL PROCEDURE file (#725). 

 Users must have the Management Security ECMGR key to access this report. 

 After previewing the report, the user has the option to print or close the report. 

 Select the report.  Step 1. 

 Export, Preview, Print or Cancel the report. Step 2. 
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Figure 130: National/Local Procedure Codes with Inactive CPT Codes Requirements 

 

Figure 131: National/Local Procedure Codes with Inactive CPT Codes Report Print Preview 

  

Figure 132: National/Local Procedure Codes with Inactive CPT Codes Report from Export 

 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 96 

Patch EC*2.0*131 

 

4.3.2.10 National/Local Procedure Report – Active Procedures 

 Use the Procedure - Add or Update Local Procedures option to create local procedures before 
using this option. 

 This report is accessible to Management users only. For users without the Management 
Security key (ECMGR), this report will not appear.  

 After previewing the report, the user has the option to print or close the report. 

 Click the Active button. Step 1. 

 Choose a Preferred Report (National, Local or Both). Step 2. 

 Choose the Sort Method (Procedure or National Code). Step 3. 

 Export, Preview, Print or Cancel the report. Step 4. 

Figure 133: National/Local Procedure Report (Active) Requirements 
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Figure 134: National/Local Procedure Report (Active) from Print Preview 

 

Figure 135: National/Local Procedure Report (Active) from Export 

 

4.3.2.11  National/Local Procedure Report – Inactive Procedures 

 Use the Procedure - Add or Update Local Procedures option to create local procedures before 
using this option. 

 This report is accessible to Management users only. For users without the Management 
Security key (ECMGR), this report will not appear.  

 After previewing the report, the user has the option to print or close the report. 

 Click the Inactive button. Step 1. 

 Export, Preview, Print or Cancel the report. Step 2. 

Note:  

 If the report is marked as Inactive, the preferred report and sort method will be disabled. 
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Figure 136: National/Local Procedure Report (Inactive) Required Fields 

 

Figure 137: National/Local Procedure Report (Inactive) from Print Preview 
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Figure 138: National/Local Procedure Report (Inactive) from Export 

 

4.3.2.12 Print Category and Procedure Summary (Report) 

 Use the DSS Unit - Add or Update DSS Units option to create DSS Units categories before 
using this option. 

 Use the Category - Add or Update Categories option to create categories before using this 
option. 

 Use the Procedure - Add or Update Local Procedures option to create procedures before using 
this option. 

 This report is accessible to Management users only. This report will not appear for users 
without the management security key (ECMGR). 

 After previewing the report, the user has the option to print or close the report. 

 Select one or all Location(s).  Step 1. 

 Select one or all DSS Unit(s). Step 2. 

Note:  

 If “All” is selected for the DSS Unit, the Category will also be “All” and will be disabled. 

 Select a Category. Step 3. 

 Note: Categories only appears if the Event Code Screen uses categories to group Step 4. 
procedures. 

 Select Active, Inactive or Both (Active and Inactive) EC Code Screens. Step 5. 

 Export, Preview, Print or Cancel the report. Step 6. 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 100 

Patch EC*2.0*131 

 

Figure 139: Print Category and Procedure Summary (Report) Required Fields 
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Figure 140: Print Category and Procedure Summary (Report) from Print Preview 

 

Figure 141: Print Category and Procedure Summary (Report) from Export 

 

4.3.2.13 Send No Records DSS Units Report  

 This report is accessible to Management users only. This report will not appear for users 
without the management security key (ECMGR). 

 Lists active DSS Units with send to PCE status of Send NO RECORDS. 

 Includes DSS Unit Name and IEN, Associated Stop Code (and Credit Stop and/or CHAR4 
Code if present). 

 After previewing the report, the user has the option to print or close the report. 

 Export, Preview, Print or Cancel the report. Step 1. 
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Figure 142: Send No Records DSS Units Report Required Fields 

 

Figure 143: Send No Records DSS Units Report from Print Preview 
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Figure 144: Send No Records DSS Units Report from Export 

 

4.4 Management Menu  
The Event Capture Management Menu is available for users with the ECMGR security key. The main 

menu in the Management Menu provides the following management functions: 

 Location – Update Location Information 

 DSS Unit – Add or Update DSS Units 

 Access by User – Grant Access to DSS Units by User 

 Category – Add or Update Categories 

 Procedure – Add or Update Local Procedures 

 Reason – Add or Update Procedure Reasons 

 Event Code Screen – Add or Update Event Code Screens 

 Inactivate EC Screen – Identify/Inactivate Multiple Event Code Screens 

Figure 145: Event Capture Management Main Menu 
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4.4.1 Location – Update Location Information 
Before the User Starts 

 Location selected must be in the INSTITUTION file (#4). 

 Locations must be created with this option before the user can establish DSS Units. No further 
options are functional until the user creates an Event Capture location. 

What the User Will See 

 Selecting the Location - Update Location Information option opens a screen that displays all the 
known location names, State, Facility Type, Station Number and Current Status in matrix form. 
The column width is adjustable. 

 From the first screen, double-click on a row or highlight a row and click the Update button. 

Figure 146: Management Menu (Locations) Screen 

  

After selecting a location, an edit screen will appear, allowing the user to create the location as a current 

Event Capture location, or to remove the selected location.  

Figure 147: Edit Location Screen 
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The rows can be sorted by using the Sort menu, or by clicking on the column header. 

Figure 148: Sort Menu Options 

  

To create a current location, click the checkbox labeled “Create as current Event Capture location” and 

click the OK button. The location is “flagged” as active for use in the Event Capture software.  

Figure 149: Creating a Current Location 

  

To remove a current location, click the checkbox labeled “Remove as current Event Capture location” and 

click the OK button. The location is “flagged” as inactive for use in the Event Capture software. 

Figure 150: Removing a Current Location 

  

Click the Export button to export the Locations listing to Excel. The tab in Excel is titled “ECS Location 

Table Export.” 
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Figure 151: ECS Location Table Export from Excel 

  

4.4.2 DSS Unit – Add or Update DSS Units 

Before the User Starts 

 Use the Location - Update Location Information option to create an Event Capture location 
before using this option.  

 A prompt displays a notification to enter an Associated Stop Code only if the "Send to PCE" flag 
is set to NO or NULL. 

 No further options are functional until DSS Units are created. 

What the User Will See 

 After selecting DSS Unit from the Management Menu, the first screen will display a list of DSS 
Units. Click the Update button to update an existing DSS Unit or click the Add button to add a 
new DSS Unit. 
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Figure 152: DSS Units Screen on Management Menu 

  

The DSS Units screen contains the following columns: 

 DSS Unit Name 

 Unit IEN 

 Active Status for DSS Unit (Yes or No)  

 The PCE column reflects if workload is set to pass to PCE. Values include:  

– ALL – Send all records 

– Outpatient – Send outpatient only 

– No – Send no records. 

 DSS Department 

 Service 

 Medical Specialty 

 Cost Center 

Using the Find  button, the user can search by DSS Unit, DSS Dept. and Unit IEN. Type in a partial 

search string, click Find and the screen will position to the first entry matching the search criteria. 

The Print button enables users to print the report.  

The Export button enables users to export the data to an Excel spreadsheet. 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 108 

Patch EC*2.0*131 

 

Figure 153: Report Exported into Excel 

 

Click Update to update an existing DSS Unit or click Add to add new one. The Edit a DSS Unit or Add a 

DSS Unit screen will appear. 

Figure 154: Edit a DSS Unit Screen 

 

Below are the element name and description for each field that appears on the Add or Edit DSS Unit 

screen:  

Table 2. Element Name and Description 

Element Name Description 

DSS Unit Name The name of the DSS Unit being created 

DSS Dept. and DSS 
Unit IEN 

The number to identify this DSS unit locally at the user’s site (1 to 14 characters) 
- The same DSS Unit number can be used for more than one DSS Unit  

Service The service associated with this DSS Unit - from the SERVICE/SECTION file 
(#49) 
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Element Name Description 

Medical Specialty The medical specialty associated with this DSS Unit - from the MEDICAL 
SPECIALTY file (#723) 

Cost Center The cost center associated with this DSS Unit - from the COST CENTER file 
(#420.1). Cost centers are defined in MP4-Part V, Appendix B of the Fiscal 
Service cost manuals. 

DSS Unit Status Active - Lists Active Event Code Screens 

Inactive - Lists Inactive Event Code Screens  

Event Code Screens Reactivate 

Remain Inactive  

Default Date / Time NOW – The current date and time will populate during data entry 

NONE – No default date and time will be populated during data entry. The user 
is required to enter the date and time of the procedure. 

Allow Category Use YES – Use categories to group procedures during data entry  

NO – Do not use categories to group procedures during data entry 

Send to PCE Defines the method used to send the user’s data to PCE for the DSS Unit being 
created. 

All Records - Send All Records 

No Records - Send No Records 

Associated Stop 
Code 

Select the Stop Code associated with this DSS Unit. Be sure to select an active 
Stop Code.  

Credit Stop Code Select the Credit Stop Code associated with this DSS Unit 

CHAR4 Code Select the CHAR4 Code associated with this DSS Unit 

 

On add or edit screens, the status defaults to Active. The Allow Category Use field defaults to No, but the 

user can select Yes. The Send to PCE option can be setup for No Records, and the Associated Stop 

Code field is enabled. A search for the Associated Stop Code can occur by description or code, resulting 

in both the description and the code displaying. When Send to PCE is set to All Records, the Associated 

Stop Code field will not be visible. All other default options can be changed. 

4.4.2.1 Add a DSS Unit 

 Click on the Add button.  Step 1. 

 Enter a DSS Unit Name.  Step 2. 

 Enter a DSS Dept  Step 3. 

 Select a Service from the list provided.  Step 4. 

 Select a Medical Specialty from the list provided.  Step 5. 

 Select a Cost Center from the list provided. Step 6. 

 Select the DSS Unit Status Step 7. 

 Choose the Date / Time Default. Step 8. 

 Choose whether or not to Allow Category Use. Step 9. 

 Choose which records will be sent to PCE. Step 10. 

 Click the OK button when selections are complete. Step 11. 
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4.4.2.2 Update a DSS Unit 

 Select a DSS Unit from the list of DSS Units and click the Update button. Step 1. 

 The Edit DSS Unit screen will be displayed. On this screen, the DSS Unit Name, DSS Step 2. 
Dept., Service, Medical Specialty, Cost Center, DSS Unit Status, Event Code Screens 
status, Default Date / Time, Send to PCE, Allow Category Use, Associated Stop Code, 
Credit Stop Code, and CHAR4 Code fields can be updated.  

Notes:  

 DSS Unit Status may be Active or Inactive. 

 The Event Code Screens options are different when Inactive is chosen for DSS Status. 

Figure 155: Original Active/Inactive Status 

 

When the DSS Unit Status is changed, the Event Code Screens options also change. 

Figure 156: Change from Active to Inactive or Inactive to Active 

 

 If the user selects Retain, the DSS Unit will remain active. 

 If the user selects Inactivate, the DSS Unit that was active will be inactivated.  

 Once a DSS Unit is inactive, the user can activate the DSS Unit again by selecting Reactivate.  

 If the user selects Remain Inactive, the DSS Unit will remain inactive. 

 Click the OK button when selections are complete. Step 3. 

4.4.2.3 To Grant Access to a DSS Unit 

From the Add or Update DSS Units screens, the user has the option to give specific users access to the 

DSS Unit being added or edited. 

 Click on the Access button at the bottom of the Add or Edit DSS Unit screen.  Step 1. 

 The Grant Access to DSS Unit Screen has Include and Exclude fields. Step 2. 

 The user can type the starting characters of the last name in the upper portion of the Step 3. 
Excluded list box, or simply scroll through the list to search for a last name. The 
Excluded list box contains the names of all active VistA users at the site. 

 The DSS manager grants access to a specific DSS unit by moving a user to the Included Step 4. 
list box, either by highlighting a name in the Excluded list box and clicking the Include 
button, or by simply double-clicking the name in the Excluded list box. Access is denied 
by moving the user to the Excluded list box, either by highlighting a name in the 
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Included list box and clicking the Exclude button, or by simply double-clicking the name 
in the Included list box .  

 Clicking the Apply button will save the changes and allow the user to grant access to Step 5. 
additional users; clicking the OK button will save the changes and return the user to the 
previous screen. 

Note:  

 The IEN and Person Class/Classification for a selected user appear below its associated 
Excluded or Included list box. 

Figure 157: Grant Access to DSS Unit Screen 

 

Note:  

 Information has been deleted intentionally to preserve privacy 

4.4.2.4 To Disable Categories for a DSS Unit 

 Select a DSS Unit which allows categories from the list of DSS Units and click the Step 1. 
Update button. 
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Figure 158: Edit DSS Unit Screen Showing a DSS Unit Set to Allow Categories 

 

 The Edit DSS Unit screen will be displayed. In the Allow Category Use section, click the Step 2. 
No radio button, then click the Ok button. 

Figure 159: Allow Category Use Set to No 

 

 A warning pop up window appears stating that if you disable the categories for this DSS Step 3. 
Unit, this setting cannot be re-instated.  Click Yes. 

Figure 160: Disable Category Warning Pop Up Message 

 



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 113 

Patch EC*2.0*131 

 

 On the Edit DSS Unit screen, the Event Code Screens section shows “None” listed in the Step 4. 
Categories column.  The Allow Category Use section is now disabled. 

Figure 161: Edit DSS Unit Screen After Disabling Categories 

 

 Click Ok to return to the Management Menu [DSS Units] screen. Step 5. 

Note: 

 Once categories are disabled for a DSS Unit, any fields for entering category information 
for that DSS Unit will be disabled on all Event Capture screens 

 Once categories are disabled for a DSS Unit, any previously entered workload will remain 
available for viewing and editing 

 A report is available to Management users which lists all DSS Units that have changed 
from Allowed to Disabled Categories. (See Section 4.3.2.2) 

4.4.3 Access by User - Grant Access to DSS Units by User 
Before the User Starts 

 Use extreme caution when utilizing this option. Removing access to a specified DSS Unit for all 
users and inactivating the DSS Unit is not recommended without the permission of the 
associated service. 

 Contact each service for a list of its Event Capture users and the DSS Units for which they 
enter data. 

 The user must have access to a given DSS Unit before procedure data can be entered. 

 Access can be provided to all DSS Units by assigning the ECALLU security key to a specified 
user (normally the DSS Manager or designee) using the Allocation of Security Keys option in 
the Key Management Menu under the Menu Management Menu.  
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Note:  

 This option cannot be used to remove access to DSS Units for users who hold the ECALLU 
security key. 

4.4.3.1 To Assign User Access to DSS Units 

 Click on the Access by User - Grant Access to DSS Units by User button.  Step 1. 

 When the screen opens, a list of users appears at the top of the box. Select a user. Step 2. 

Figure 162: Grant Access to DSS Units by User 

 

 Select the names of the DSS Unit(s) by highlighting the particular unit and clicking on Step 3. 
the Include button.  

Figure 163: Grant Access to DSS Units by User 
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 Click the Apply button to apply the changes and continue working, or click the OK Step 4. 
button to apply the changes and exit the screen. 

Note: 

 The user can print a list of users identified as having access to a given DSS Unit by clicking 
the Print button. 

4.4.4 Category - Add or Update Categories 

Before the User Starts 

 The user can ignore this option if the site’s DSS Units are defined for use without categories. 

 Categories cannot be deleted, but this option can be used to inactivate or reactivate them. 

What the User Will See 

 After selecting Category – Add or Update Categories from the Management Menu, the first 
window displays a list of Category Names, the Date created, and the Inactivation Date. 

Figure 164: Categories Main Screen on Management Menu 

 

 The second screen enables the user to add a Category or to update a selected Category. The 
second screen contains fields called Category Name and Status. 

4.4.4.1 To Add or Update Categories 

 To add a new local category: Step 1. 

 Click the Add button on the screen, or click the Add menu item in the Edit menu. The Status 
field defaults to “Active”. 
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Figure 165: Add Category Screen 

 

 Enter the name of the category to be added, then click the OK button. 

 To update an existing local category: Step 2. 

 From the list of categories, select the category record to modify and click Update. The Update 
Category screen is displayed.  

 Change the category to its new status by clicking Active or Inactive. Click the OK button to file 
the change and return to the previous screen. 

Figure 166: Update Category Screen 

 

 The Categories screen on the Management Menu will reflect the changes made.  If the Step 3. 
category was inactivated, the Inactivation Date will display the current date. 

 The Export button enables users to export the data to an Excel spreadsheet. Step 4. 

Figure 167: ECS Category Table Export from Excel 

 

4.4.5 Procedure - Add or Update Local Procedures 

Before the User Starts 
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 Before using this option, print the National/Local Procedure Report from the Reports menu of 
the Event Capture Main Menu to print a list of procedures with their associated CPT codes. 
This report can be lengthy if it includes national procedures. This should be queued to print to a 
device during non-peak hours. 

 Enter an associated CPT code to pass local procedures to the PCE software. 

 A local procedure code number is required for any new local procedure.  

 The local number code must be five characters in length, starting with an uppercase alpha 
character, followed by four alpha or numeric characters. 

 With functionality put in place by the Code Set Versioning project, only active CPT codes are 
made available, and are based on the date a local procedure is added. 

What the User Will See 

 After selecting Procedure - Add or Update Local Procedures from the Management Menu, the 
first screen displays a list consisting of Procedure Name, Number, CPT Code and CPT 
Description, and Active status. 

Figure 168: Procedures Main Screen Management Menu 

 

 The detail screen enables the user to add a Local Procedure. This screen contains the 
following fields: Procedure Name, Procedure Number, CPT Code and Description, and Status.  



 User’s Manual 

September 2016 Event Capture v 2.0 GUI User’s Manual 118 

Patch EC*2.0*131 

 

Figure 169: Add Local Procedure 

 

 Local procedures cannot be deleted, but this option can be used to inactivate or reactivate 
them. 

 The CPT Code and Description field contains CPT Code look-up functionality. The user can 
search for an existing CPT Code by code, a portion of the code, or a part of the description.  

 When attempting to file a new Local Procedure, the system compares the new procedure to the 
National Procedure code file to prevent duplication. A message is displayed, and the local 
procedure is not added. 

Instructions to Add or Update Local Procedures 

 To add a new local procedure: Step 1. 

 Click the Add button on the screen, or click the Add menu item in the Edit menu. 

 Enter the new local Procedure Name. 

 Enter the local Procedure Number. 

 Enter the CPT Code if the data will transmit to the PCE software. 

 Click the OK button. The new local procedure has been added. 

Figure 170: Adding a Local Procedure 
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Figure 171: Update a Local Procedure 

 

 To update an existing local procedure: Step 2. 

 Highlight the existing record and click the Update button, or double-click the row.  

 Edit the Procedure Name, Procedure Number, CPT Code and Description, and/or Status. 

 Click the OK button. The local procedure has been updated. 

Figure 172: Editing a Local Procedure 
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Figure 173: Update After Editing a Local Procedure 

 

 Click the Export button to export the Procedures listing to Excel; the tab in Excel is titled “ECS 
Procedure Table Export”. 

Figure 174: Export of Procedures into Excel 

 

4.4.6 Reason - Add or Update Procedure Reasons 
Before the User Starts 

 Users with the ECMGR security key can activate or inactivate existing reasons. If a reason is 
listed as inactive, it will not appear on the dropdown list for reasons on any screen. 

 Event Capture managers can add a new reason using the Event Capture – New Reason 
screen.  

What the User Will See 
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 After selecting Reason – Add or Update Procedure Reasons from the Management Menu, the 
first screen displays a list of Active Reasons and Inactive Reasons. 

Figure 175: Management Menu (Reasons) Screen 

 

4.4.6.1 Activate Reasons 

 Highlight one or more items from the Inactive Reasons list box and click the Activate button. To 
move more than one reason, click and hold the <Ctrl> key and then highlight additional items. 

Figure 176: Reasons Screen with Inactive Reasons Highlighted 

 

 The Inactive Reason(s) selected will appear in the Active Reasons column when the Activate 
button is clicked. 
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Figure 177: Reasons Screen with Inactive Reasons Moved to the Active Column 

 

 Click the OK or Apply button to update the reason(s). A confirmation prompt will appear. Click 
the Yes button to save the changes.  

Figure 178: Confirmation Prompt 

 

4.4.6.2 Inactivate Reasons 

 Highlight item(s) from the Active Reasons list box and click the Inactivate button.  Step 1. 

 To move more than one reason, click and hold the <Ctrl> key and then highlight additional 
items. 

Figure 179: Reasons Screen with Active Reasons Highlighted 

 

 The Active Reason(s) selected will appear in the Inactive Reasons column when the Inactivate 
button is clicked. 

Figure 180: Reasons Screen with Active Reasons Moved to the Inactive Column 

  

 Click the OK or Apply button to update the reason(s). A confirmation prompt will appear. Step 2. 
Click the Yes button to save the changes.  
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Figure 181: Confirmation Prompt 

 

4.4.6.3 Add a New Reason 

 Click the Add button. The Event Capture – New Reason screen will appear. Step 1. 

Figure 182: Event Capture – New Reason Screen 

 

 Type the value of the new reason. Click the OK button to add the reason to the Active Step 2. 
Reasons column. Click the Cancel button to exit the screen without saving the record. 

Figure 183: Reasons Screen with New Reason Added 

 

4.4.7 Event Code Screen:  Add, Update, or Copy Event Code 
Screens 

Before the User Starts 

 Use the Location - Update Location Information option to create an Event Capture location 
before using this option.  

 Use the DSS Unit - Add or Update DSS Units option to establish DSS Units before using this 
option. 

 Event Code screens must be defined before entering any Event Capture data. 

 A prompt for Category occurs only if the Event Code screen uses categories to group 
procedures. 
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 The user must define an active Associated Clinic and CPT code to pass Event Code 
procedures to PCE.  

 With functionality put in place by the Code Set Versioning project, only active CPT codes can 
be selected and they will be based on the date the event code screen is being set up.  

 The Event Code screen enables the use of characters “/” and “-” in the search field. 

 The Associated Clinic on the Event Code screen is not auto-populated. 

 The Print and Export buttons have been added to the Event Code Screen. 

 Users with the ECMGR key will be able to copy EC screens to another DSS Unit  

What the User Will See 

 After selecting Event Code Screen - Add or Update Event Code Screens from the Management 
Menu, the first screen displays a dropdown box of DSS Units.  

 Select a DSS Unit to display the Event Code Screen data.  Columns include Synonym, 
Procedure, Location, Default Associated Clinic, Category and Status.  

Figure 184: Event Code Screens Example 

 

 The Event Code Table Report can be printed. When printing the report, the user will be 
prompted to choose Active, Inactive or All for the Clinic Status. 
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Figure 185: Select Clinic Status for the Report 

 

 The Event Code Table Report can also be exported to Excel. The user will be prompted to 
choose Active, Inactive or All for the Clinic Status. The Excel spreadsheet columns included in 
this report are Synonym, Procedure, Location, Default Associated Clinic, Category and Status. 
The spreadsheet tab is “Event Code Table Export”. 

Figure 186: Exported Event Code Table Report 

 

 Highlight the Procedure and click the Update button. The Update Event Code Screen form 
contains the following fields:  DSS Unit, Category, Location, Procedure, Status, Procedure 
Synonym, Default Volume, Ask Reasons, and Default Associated Clinic. 

Figure 187: Update Event Code Screen Example 
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 Select a Default Associated Clinic. The list box displays only active locations in the HOSPITAL 
LOCATION file (#44) whose type is “C” (clinic) and is a “count” clinic. In addition, if an 
Associated Clinic has non-conforming stop codes, the clinic will not be selectable.  

4.4.7.1 Setting a DSS Unit to Send Data to PCE 

Instructions to add an Event Code Screen: 

 After selecting a DSS Unit from the dropdown box, click the Add button, or select the Step 1. 
Add menu item from the Edit menu.  

 At the appropriate dropdown boxes select the DSS Unit, Category (if enabled), Location Step 2. 
(one/many/all), Procedure, Status, Procedure Synonym, Default Volume, Ask Reasons 
and Default Associated Clinic.  

 Click the OK button.  Step 3. 

Figure 188: Adding an Event Code Screen 

 

To Update an Event Code Screen: 

 Click on an Event Code Screen from the list of Event Code Screens for the selected DSS Step 1. 
Unit. 

 Click the Update button, or select the Update menu item from the Edit menu.  Step 2. 

Note:  

 An error message appears if a user selects an Event Code Screen that has an inactive 
Associated Clinic.  The user has the option to select an appropriate active clinic or to leave 
the Associated Clinic blank. 
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Figure 189: Invalid Associated Clinic Error 

 

 Update the Status, Procedure Synonym, Default Volume, Default Associated Clinic, and Step 3. 
Ask Reasons.  

 Click the OK button.  Step 4. 

Figure 190: Update an Event Code Screen 

 

Instructions to Copy EC Screens to another DSS Unit 

 Highlight a DSS Unit that has an Active status. Step 1. 
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Figure 191: Event Code Screen with Active DSS Unit Selected 

 

 Click the Edit menu and select the Copy EC Screens to another DSS Unit menu item. Step 2. 

Figure 192: Copy EC Screens to Another DSS Unit on Edit Menu 

 

 The Select a target screen appears. Select a target DSS Unit (usually newly created) from Step 3. 
the dropdown list, then click the OK button. 

Figure 193: Select a Target Screen 

 

 The Copy Event Capture Screen to <user-selected target DSS Unit> displays.  Step 4. 

 The Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default 
Associated Clinic fields can be modified on this screen. 

 The DSS Unit, Category, and Procedure cannot be edited. 
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Note:  

 The target DSS Unit is usually newly created by the user, but an existing DSS Unit may 
also be used. 

Figure 194: Copy Event Code Screen 

 

 Location, Status, Procedure Synonym, Default Volume, Ask Reasons and Default Associated 
Clinic can be modified on this screen.  

Note:  

 If the DSS Unit is setup to not send records to PCE, the Default Associated Clinic is 
disabled. 

 One, many or all Event Code Screens can be copied. Step 5. 

 To copy an Event Code Screen, review the field selections and make edits (if necessary). Click 
the OK button to save the changes, creating the copy.  The next Event Code Screen will 
appear. 

 To skip an Event Code Screen, click the Skip this EC Screen button. The next Event Code 
Screen will appear. 

 When all needed Event Code Screens are copied, select the Close button to return to the Event 
Code Screen. All of the previous changes will be saved. 

Note:  

 If the user does not select a Location when copying an Event Code Screen, the record will 
not be filed and the following two error messages will appear: 

Figure 195: Record Not Filed Error Message for Key Data Missing 
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Click the OK button on each error dialog to return to the Copy Event Code Screens form and enter a 

Location. 

4.4.8 Inactivate EC Screen: Identify Inactive Multiple Event Code 
Screens 

Before the User Starts 

 Users with the ECMGR security key can select an EC Product Code (CPT Code, National EC 
Procedure Code or Local EC Procedure Code) and then display all of the DSS Units using the 
selected Product Code on the Inactivate Selected Event Code (EC) Screens for Given 
Procedure Code form.  

 Choose to inactivate Event Code Screens by utilizing the checkboxes in front of each entry. 
The user can display and print a list of Event Code Screens inactivated for a chosen EC 
Product Code. 

What the User Will See 

 After clicking the Inactivate EC Screen button from the Management Menu, the Event Capture 
– Inactivate Selected Event Code (EC) Screens for Given Procedure Code form will be 
displayed. 

 Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local EC 
Procedure Code).  The associated DSS Units with IENs, Locations and Categories appear for 
the EC Product Code selected. 

 Checkboxes are available to the left of each entry. The user can select multiple checkboxes. 

Figure 196: Inactivate Selected Event Code (EC) Screens for Given Procedure Code 

 

Instructions for Inactivating Event Code Screen(s) 

 Enter an Event Capture Product Code (CPT Code, National EC Procedure Code, or Local Step 1. 
EC Procedure Code). 
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 The list shows all currently active Event Capture Product Codes. Use the checkboxes on Step 2. 
the left side of the screen to select entries to be inactivated. 

Figure 197: Entries Selected to be Inactivated 

  

 Click the Apply or OK buttons to Inactivate.  Step 3. 

 A confirmation message dialog will appear. Click the Yes button to inactivate the Step 4. 
selection(s), or click the No button to return to the previous screen. 

Figure 198: Confirmation Message Dialog for Inactivate Event Code Screens 

   

 If the Yes button is clicked in response to the confirmation prompt, a listing of the Event Step 5. 
Code Screens that were inactivated will be displayed. 
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Figure 199: Event Code Screens That Were Inactivated 

  

 There will be an option to Print this list of inactivated screens or click the OK button to Step 6. 
return to the previous screen. 

 To verify that the Event Code Screens are inactivated, reenter the Event Code Product Step 7. 
Code that was previously used. The list of DSS Units, Locations and Categories does not 
include the inactivated Event Code Screens. 

Figure 200: Verifying that EC Screens were Inactivated 
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5 Troubleshooting 

5.1 Access Issues 
Users need an Access Code and Verify Code obtained from their local Information Resource 

Management (IRM) staff to use the Event Capture GUI. 

5.2 Log On Issues 
Event Capture is usually accessed through a desktop shortcut which points to the installation location. 

Ask the local support staff for assistance.  

If Event Capture launches and then disappears or is not responding, make sure the listed IP address is 

correct and not blocked by firewall software for the system with which it is communicating. Local support 

staff is available to assist with issues. 

5.3 GUI Appears Distorted 
If the ECS GUI display appears to be missing scrollbars, columns or rows, ensure that the screen 

resolution is set to a resolution of 1440 x 900 or greater. 

5.3.1 Example of Setting the Screen Resolution to 1600 x 900 
 Right-click on the desktop and select Screen resolution. Step 1. 

Figure 201: Desktop Menu Displayed After Right Click 
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Figure 202: Screen Resolution Display 

 

  Select Normal size (1600 x 900) from the Resolution setting dropdown box and then Step 2. 
click the OK or Apply button. 

Figure 203: Menu Displayed After Selecting Screen Resolution Button 
(NVIDIA Graphics Card Menu) 
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Appendix A: Acronyms 

Acronym Description 

ADPAC Automatic Data Processing Application Coordinators 

CCOW Clinical Context Object Workgroup 

CHAR4 
A 4-character code value of the associated clinic as specified from the 

DSS Clinics and Stop Code Worksheet File. 

CM Clinical Modification 

CPRS Computerized Patient Record System 

CPT Current Procedural Terminology 

CSV Code Set Versioning 

DIAG Diagnosis 

DOB Date of Birth 

DSS  Decision Support System  

Dx Diagnosis 

EC Event Capture 

ECALLU Security Key - Event Capture All DSS Units 

ECMGR Security Key - Event Capture Manager 

ECNORPT Security Key - Event Capture No Reports 

ECPATIENT Event Capture Patient 

ECPROVIDER Event Capture Provider 

ECS Event Capture System 

ECSPSH Security Key - Event Capture Spreadsheet 

FAQ Frequently Asked Questions 

FY Fiscal Year 

GUI Graphical User Interface 

ICD International Classification of Diseases 

ID Identification 

IP Internet Protocol 

IPC Inactive Person Class  

IRM Information Resource Management 

IT Information Technology 

MAS Medical Administration Service  

MISC Miscellaneous 

N/A Not Applicable 

NPCD National Patient Care Database 

O&E Observation and Examination 

PCE Patient Care Encounter 

PIMS Patient Information Management System 

SHAD Shipboard Hazard and Defense 
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SSN Social Security Number 

SW Southwest 

T&TC Section 508 Accessibility Testing and Training Center 

VA Veterans Affairs 

VAMC Veterans Affairs Medical Center 

VAMROC Veterans Affairs Medical and Regional Office Center 

VistA Veterans Health Information Systems and Technology Architecture 
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Appendix B: Glossary 

Term Description 

Associated Stop Code The Stop Code that most closely represents the DSS Unit workload. 

Category Category provides Event Capture a common level to group associated 
procedures. Multiple procedures can be defined for each category. 

CCOW In the context of health informatics, CCOW is a Health Level-7 international 
standard protocol designed to enable disparate applications to synchronize in 
real time, and at the user interface level. 

CHAR4 Code A 4-character code value of the associated clinic as specified from the 

DSS Clinics and Stop Code Worksheet File. 

Cost Center Cost Center reveals which service is using this DSS Unit. Cost Centers are 
defined in detail in MP4-Part V, Appendix B of the Fiscal service cost manuals. 

Conforming Clinics Clinics that have stop codes in compliance with their restriction types. Stop 
codes are used in accordance to their assigned restriction types. Stop codes 
with restriction type 'P' can only be used in the primary stop code position. 
Stop codes with restriction type 'S' can only be used in the secondary stop 
code position. Stop codes with restriction type 'E' can be used in either the 
primary or secondary stop code position. 

Count Clinic A clinic for which workload entered is credited. 

CPRS Acronym for Computerized Patient Record System 

CPT code CPT codes are published by the American Medical Association.  The purpose 
of the coding system is to provide uniform language that accurately describes 
medical, surgical, and diagnostic services. 

CPT Modifier CPT modifiers provide the ability to refine CPT procedure codes to better 
reflect procedures performed. 

CSV Code Set Versioning 

The Health Information Portability and Accountability Act (HIPAA) mandated 
that applications using CPT codes, CPT modifiers, and diagnosis codes should 
allow users to select codes based upon a date that an event occurred.  

DSS Unit A DSS (Decision Support System) Unit defines the lowest level segment used 
for tracking hospital resources. These units can be a small work unit within a 
service or a large division within a service. Management at each facility is 
responsible for tailoring the DSS Units to fit its resource/cost reporting. 

DSS Unit Number This code is used for additional identification of DSS Units. 

Event Capture Software designed to provide management tools necessary in tracking 
procedures not entered in other VistA packages. 

Event Code Screen Event Code Screens are unique combinations of location, DSS Unit, category, 
and procedure that define patient procedures. 

ICD-10-CM International Classification of Diseases, Tenth Revision, Clinical Modification 
codes (based on the World Health Organization codes)  

Location Initializing the user site as a location, the Event Capture software recognizes 
the user facility as a valid location to enter Event Capture data. 

MAS Acronym for Medical Administration Service, which is now Patient Information 
Management System (PIMS). 

Non-conforming Clinics Clinics with stop codes that do not comply with the assigned stop code 
restriction types of P=Primary, S=Secondary and E=Either. 
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Term Description 

Non-count Clinic A clinic for which there is no workload credited. 

Ordering Section The medical section ordering the patient’s procedure. 

Parent Service The controlling service for a DSS Unit. 

PIMS Patient Information Management System, formerly Medical Administration 
Service (MAS). 

Procedure A specific function performed on, or service provided to, a patient. Multiple 
procedures can be associated with a single category. 

Procedure Reason A method of generically grouping patient procedures to further describe the 
event, often giving patient or provider information. 

Procedure Synonym See Synonym 

Provider The provider of care performing the procedure. This provider can be a doctor, 
nurse, technician, or any designated team of medical professionals. 

Reason See Procedure Reason 

Synonym A locally recognized name or description for a procedure 

T&TC Section 508 Accessibility Testing and Training Center 

Volume Volume is usually associated with the number of procedures performed. This 
field can also be used to track number of bed days, or to track time increments 
actually spent performing the procedure. (For example, if 15 minute increments 
is the unit, volume of 1 = 15 minutes, volume of 2 = 30 minutes, etc.) 
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Appendix E: Other ECS Package Management 
Information 

Set up an ECS mail group in VistA to receive relevant ECS notifications. Contact IT to set up a VistA ECS 

Mail Group so more than one person receives ECS administrative messages. 

Examples of ECS package administrative Email messages: 

When a new ECS patch is released 
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When an EC NATIONAL PROCEDURES file (#725) patch is loaded, a review of the EVENT 
CODE SCREENS file (#720.3) is performed. Event Code Screens, which have either inactive 
CPT or Event Capture Codes, or an Event Capture Code with an inactive “default” CPT code 
attached, are reported. 
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Notes: 

After a patch updating file #725: 

 Check for inactivated national EC Procedure Codes. 

 Check for Event Code Screens with out-of-date EC Procedure Codes. 

When an ECS User is terminated 

(May inactivate national EC Procedure Codes and report any Event Code Screens with out-of-date 

Procedure Codes.) 
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